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preface

This Maintenance and Service Guide is a troubleshooting guide that can be used for
reference when servicing the Compaq Armada 1500c Series.

Compaq Computer Corporation reserves the right to make changes to the computer
without notice.

Additional information is available on the Compaq Armada 1500c Series Illustrated
Parts Map.

Symbols

The following words and symbols mark special messages throughout this guide:

! WARNING:  Text set off in this manner indicates that failure to follow directions in
the warning could result in bodily harm or loss of life.
CAUTION:  Text set off in this manner indicates that failure to follow directions
in the caution could result in damage to equipment or loss of information.

IMPORTANT:  Text set off in this manner presents clarifying information or specific
instructions.

NOTE:  Text set off in this manner presents commentary, sidelights, or interesting points
of information.

Technician Notes

! WARNING:  Only authorized technicians trained by Compaq should attempt to
repair this equipment. All troubleshooting and repair procedures are detailed to
allow only subassembly/module level repair. Because of the complexity of the
individual boards and subassemblies, no one should attempt to make repairs at the
component level or to make modifications to any printed wiring board. Improper
repairs can create a safety hazard. Any indication of component replacement or
printed wiring board modifications may void any warranty or exchange allowances.

! WARNING:  The computer is designed to be electrically grounded. To ensure
proper operation, plug the AC power cord into a properly grounded electrical outlet
only.
CAUTION:  To properly ventilate your system, you must provide at least 3 inches
(7.62 cm) of clearance on the left and right sides of the computer.
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Serial Number

When requesting information or ordering spare parts, provide the computer serial
number. The serial number is displayed on the rear of the computer.

Locating Additional Information

The following documentation is available to support the computer:

■ Compaq Armada 1500c Series documentation set

■ Microsoft operating system user’s guide

■ Service Training Guides

■ Compaq Service Advisories and Bulletins

■ Compaq QuickFind

■ Compaq Service Quick Reference Guide

■ Compaq Armada 1500c Series Maintenance and Service Guide

■ Compaq Armada 1500c Series Illustrated Parts Map

Compaq Internet site at http://www.Compaq.com
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chapter
 1

COMPUTER PRODUCT
DESCRIPTION

1.1  Computer Features and Models

The Compaq Armada 1500c Series is a line of multimedia notebook computers with
advanced modularity, processors, and video graphics. This full-function, Celeron-based
series of notebook computers allows full desktop functionality and connectivity
through the use of an optional Convenience Base II.

Figure 1-1. Compaq Armada 1500c Personal Computer
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1.2  Standard Features
The Compaq Armada 1500c Series models have the following standard features:

■ 266- or 300-MHz Celeron processors with 128-Kbyte embedded cache memory

■ 32MB of synchronous dynamic random access memory (SDRAM), expandable to
160 MB

■ 4.0-, 5.0-, or 6.0-GB, 2.5-inch (12.7mm) internal hard drive

■ 12.1-inch Color Thin Film Transistor (CTFT) SVGA or 12.1-inch Dual Supertwist
Nematic (DSTN) SVGA display

■ Nickel Metal Hydride (NiMH) modular battery pack

■ SoundBlaster−compatible audio controller with internal stereo speakers and internal
microphone

■ Full-size 101 key compatible keyboard including 12 function keys, 8 cursor control
keys, inverted-T cursor control keys, and embedded numeric keypad

■ Four user-programmable keys

■ Touchpad pointing device

■ Power Sources include the following:

❏ Internal Nickel-Metal Hydride (NiMH) modular battery pack

❏ External AC adapter

■ Power management and security features

■ Two standard device slots that will accommodate two type I or II PC Cards, or one
type III PC Card, PCMCIA, and CardBus cards

■ 176 pin expansion connector provides the interface to the convenience base options

■ Rear-panel ports provide connections for USB, parallel and serial, external monitor,
and keyboard/mouse

■ Integrated 56Kbps modem (North America only)

■ CD-ROM Drive or DVD-ROM Drive

■ Quick Restore CD

1.2.1 Software Fulfillment
Replacement software can be ordered directly from Compaq Computer Corporation.
Both the model and the serial numbers of the computer are needed to identify the
specific software available.
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1.3  Options
The computer supports the following options:

■ Convenience Base II pass through model
■ Convenience Base II with Ethernet
■ Memory expansion boards
■ Li-Ion battery pack
■ Aircraft/Automobile adapter
■ External battery charger
■ PCMCIA modem
■ AC power cords
■ Hard drive upgrade
■  Internal DVD-ROM drive

1.3.1  Convenience Base II
The computer supports the following convenience base models:

■ Convenience Base II pass through
■ Convenience Base II with Ethernet

1.3.2  System Memory Options
The computer supports optional 16-, 32-, 64-, and 128-MB memory boards. The
memory boards are 66-MHz SDRAM without parity. System memory can be expanded
to 160 MB of DRAM.

Table 1-1 describes the possible memory configurations for the computer.

Table 1-1
Memory Configuration

SODIMM Module Present Total System Memory

No SODIMM present   32 MB
  16 MB   48 MB
  32 MB   64 MB
  64 MB   96 MB
128 MB 160 MB
Any EDO in Celeron   32 MB (EDO not usable)

If an EDO memory module is placed into a Celeron system, a POST error message may
be printed to the screen. The new message will read “This expansion memory type
(EDO) is not supported.”
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1.3.3  External Battery Charger
The External Battery charger has the following features:

■ Two battery charge slots
■ Accepts both NiMH and Li-ion modular batteries
■ Charges one battery in 3 hours or less

1.3.4 External Keyboards and Pointing Devices
Supports Compaq or Compaq-compatible PS/2 keyboards and pointing devices

1.3.5  External Monitors
The computer supports VGA Monitors up to 1280 x 1024.

1.4  Design Overview
This section presents a design overview of the computer. The overview is limited to
field replaceable parts. All replacement parts are listed in Chapter 3.

1.4.1  System Unit
The computer is a traditional clamshell design with a display unit attached to a system
unit. The computer opens to reveal a backlit LCD display and a full-sized keyboard.
The display is designed for a continuously adjustable tilt angle.

1.4.2  Internal Boards
The system electronics are integrated on seven printed circuit assemblies: the LED
status board, I/O fixture connector, audio board, system board, modem board, and the
DC-DC converter board. An optional memory board is available that expands the
system memory up to 160 MB.

■ The LED status board connects the system board to the display cables and supports
the status LEDs.

■ The DC-DC converter board creates the system voltages (3.3v and 5.0v) from the
battery or from the 14 VDC external power supply output.

■ The system board integrates the processor, memory, local bus video adapter,
PCMCIA/CardBus adapter, and audio controller.

Processor
The processor located on the system board  is a 266- or 300-MHz Intel Celeron
processor with 128-Kbyte embedded cache.

Memory
Base memory is 32 MB with, 16, 32, 64, or 128 MB of optional expansion memory.
Base memory is onboard memory built into the system board. Expansion memory
consists of one memory expansion board available as a user-installable option.
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Cache
128-Kbyte cache is integrated with the Celeron processor. It is not user upgradable.

Audio Controller
The audio controller is located on the system board. The audio amplifiers and
connectors are on the audio board printed circuit assembly.

PCMCIA/CardBus and Video Adapter Controller
The PCMCIA/CardBus adapter is based on the Texas Instrument PCI1225 PC to
CardBus controller unit. The local bus video adapter is the Chips and Technologies
69000 controller.

■ The serial-parallel port board expands the serial and parallel signals from the system
board to the serial and parallel expansion connectors.

■ The audio board supports the microphone and headphone jacks, the volume control
switches, and the amplifier and equalization circuitry.

1.4.3  Video System
The standard video subsystem consists of:

■ 12.1 inch STN SVGA display
■ 12.1 inch CTFT SVGA display
■ An inverter to supply AC power to the LCD back-light system
■ A standard external VGA connector for use with CRTs and other VGA-compatible

displays
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1.5  External Computer Components
The external computer components are illustrated and described in this section.

1.5.1  Front and Left Side Components
The front and left side external components are shown in the following figure and
identified in this section:

1  Display latches
2  Power connector
3  RJ-11 connector (on some models)
4   PC Card eject levers
5  PC Card slots
6  DualBay compartment
7  Power/Suspend light
8  Battery charge light

Figure 1-2. Front and Left Side Components
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1.5.2  Right Side Components
The right side external components are shown in the following figure and identified in
this section:

1  Battery bay
2  Stereo/speaker headphone jack
3  Microphone jack
4  Volume control buttons
5  CD-ROM drive or DVD-ROM drive
6  Cable lock provision

Figure 1-3. Right Side Components
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1.5.3  Rear Components
The rear components are shown in the following figure and identified in this section:

1  Serial connector
2  Serial number
3  Parallel connector
4  External monitor connector
5  Docking connector
6  Airflow vents
7  USB connector
8  Keyboard/Mouse connector

Figure 1-4. Rear Components
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1.5.4  Bottom Components
The bottom external components are shown in the following figure and are identified in
this section:

1  Docking latch receptacles
2  Docking alignment guide
3  Modem compartment
4  Diskette drive
5  Diskette drive release latch
6  Battery with traction grip
7  Docking restraint latch recess

Figure 1-5. Bottom Components



1-10    Computer Product Description

1.5.5  Status Panel Lights
The status panel lights are shown in the following figure and are identified in this
section:

1  Hard drive light
2  Diskette drive light
3  NumLk light
4  Caps Lock light
5  Scroll Lock light

Figure 1-6. Status Panel Lights
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 2

TROUBLESHOOTING

Follow these basic steps when beginning the troubleshooting process:

1. Complete the preliminary steps listed in Section 2.1.
2. Run the Power-On Self-Test (POST) as described in Section 2.3.
3. Run Computer Setup as described in Section 2.5.1.
4. Run the Computer Checkup (TEST) as described in Section 2.6.
5. If you are unable to run POST or Computer Checkup, or if the problem persists after

running POST and Computer Checkup, perform the recommended actions described
in the diagnostic tables in Section 2.5.

Follow these guidelines when troubleshooting:

■ Complete the recommended actions in the order in which they are given.

■ Repeat POST and Computer Checkup after each recommended action until the
problem is resolved and the error message does not return.

■ When the problem is resolved, stop performing the troubleshooting steps and do not
complete the remaining recommended actions.

■ Refer to Chapter 5, “Computer Removal and Replacement Procedures,” for removal
and replacement procedures that are recommended.

■ If the problem is intermittent, check the computer several times to verify that the
problem is solved.

The following table describes the troubleshooting actions:

If You Want To: Then Run:

Check for POST error messages POST
Check that computer components are recognized and
running properly

Computer Checkup (TEST) under Compaq Utilities

View information about the computer and installed or
connected devices

View System Information (INSPECT) under
Compaq Utilities

Perform any of the following:
■ Check the system configuration.
■ Set the system power management parameters.
■ Return the system to its original configuration.
■ Check system configuration of installed devices.

Computer Setup
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2.1  Preliminary Steps

IMPORTANT:  Use the external power supply when running POST, Computer Setup, or
Computer Checkup. A low battery condition could initiate Hibernation and interrupt
the test.

Before running POST and Computer Checkup:

1. Obtain established passwords. If you must clear the passwords, go to Section 2.2.
2. Ensure that the hard drive is installed in the computer.
3. Ensure that the battery pack is installed in the computer and the power cord is

connected to the computer and plugged into an AC power source.
4. Turn on the computer.
5. If a power-on password has been established, type the password and press Enter.

NOTE:  The key icon appears on the display when he computer is turned on to indicate
that QuickLock/QuickBlank has been initiated. Type the power-on password to exit
QuickLock/QuickBlank. If the password is unknown, it must be cleared (see Section
2.2).

6. Run Computer Setup (Section 2.5). If a Setup password has been established, type
the password and press Enter.

7. Use the Hotkey (Fn+F10) to adjust brightness to midrange and leave the display
open.

8. Turn off the computer and all external devices.
9. Disconnect external devices that you do not want to test. If you want to use the

printer to log error messages, leave it connected to the computer.

NOTE:  If a problem only occurs when an external device is connected to the computer,
the problem could be with the external device or its cable. Isolate the problem by
running POST with and without the external device connected.

10. Use Compaq Utilities to test these ports.

To run Compaq Utilities:

a. If you are running Compaq Utilities from the hard drive, turn on or restart the
computer. Press F10 when the cursor appears in the upper right corner of the
screen. If you do not press F10 in time, restart the computer and try again.

If you are running Compaq Utilities from diskette, insert the Compaq Utilities
diskette in drive A. Turn on or restart the computer.

b. Press Enter to accept OK.

c. Select Computer Checkup (TEST).

d. Select Prompted Diagnostics.

e. After “Identifying System Hardware” completes, select “Interactive Testing” and
follow the instructions on the screen.
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2.2  Clearing Passwords

The power-on password prevents use of the computer until the password is entered.
The setup password prevents unauthorized changes to Computer Setup. To clear the
passwords, you must remove all power from the system board. If you do not know the
passwords, use the following procedure to clear the password:

1. Remove all battery packs from the battery bay and DualBay, if applicable.
2. Disconnect the external power supply.
3. Remove the real-time clock battery.
4. Wait five minutes.
5. Reconnect the external power supply.
6. Restart the computer. During Power-On Self Test (POST), a “162 System

Options not set” message appears.
7. Shut down the computer, then disconnect the external power supply again.
8. Replace the real-time clock battery.
9. Install the battery pack(s).

10. Proceed with the troubleshooting procedures.

2.3  Power-On Self-Test (POST)

The Power-On Self-Test (POST) is a series of tests that run every time the computer is
turned on. POST verifies that the system is configured and functioning properly.

To run POST:

1. Complete the preliminary steps (Section 2.1).
2. Turn on the computer.

If POST does not detect any errors, the computer beeps once or twice to indicate that
POST has run successfully. The computer boots from the hard drive or from a bootable
diskette if one is installed in the diskette drive.
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2.4  POST Error Messages

If the system is not functioning well enough to run POST, or if the display is not
functioning well enough to show POST error messages, refer to the Troubleshooting
tables in Section 2.6.

If POST detects an error, one of the following events occurs:

■ A message with the prefix "WARNING" appears, informing you where the error
occurred. The system pauses until you press F1 to continue.

■ A message with the prefix "FATAL" appears, informing you where the error
occurred. After the message, the system emits a series of beeps and stops.

WARNING messages indicate that a potential problem, such as a system configuration
error, exists. When F1 is pressed, the system should resume. You should be able to
correct problems that produce WARNING messages.

IMPORTANT:  When a WARNING message includes the prompt to "RUN SCU," press
F10 to run Computer Setup. (Computer Setup replaces the SCU utility.)

If you receive one of the error messages listed below, follow the recommended action.

Table 2-1
Warning Messages

Message Description Recommended Action

CMOS checksum invalid, run SCU CMOS RAM information has
been corrupted and needs to
be reinitialized.

Run Computer Setup to reinitialize
CMOS-RAM.

CMOS failure, run SCU CMOS RAM has lost power. Run Computer Setup to reinitialize
CMOS-RAM.

Diskette controller error The diskette drive controller
failed to respond to the
recalibrate command.

If there is no diskette drive in the
system, run Computer Setup to
properly configure the CMOS-RAM to
show no diskette drive present. If the
problem persists, or if a diskette drive
is present, complete these steps until
the problems is solved:
1. Power-down the system and

check diskette drive
connections.

2. Replace diskette drive.
3. Replace system board.

Diskette track 0 failed The diskette drive cannot read
track 0 of the diskette in the
drive.

Try another diskette. If the problem
persists, you may need to replace the
diskette drive.

Continued 
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Table 2-1  Warning Messages  Continued

Message Description Recommended Action

Diskette information invalid, run SCU The drive parameters stored in
CMOS RAM do not match the
diskette drives detected in the
system.

Run Computer Setup.

Hard disk controller error The hard drive controller failed
to respond to the reset
command.

Check the drive parameters. Turn off
the system and check all related
connections.

Hardware information does not
match video card, run SCU

The video adapter type
specified  in CMOS RAM does
not match the installed
hardware.

Run Computer Setup.

Keyboard controller failure The keyboard failed the self-
test command.

Replace the system board.

Keyboard failure The keyboard failed to respond
to the RESET ID command.

Replace the keyboard. If the problem
persists, replace the system board.

No interrupts from Timer 0 The periodic timer interrupt is
not occurring.

Replace the system board.

RAM parity error at location xxxx A RAM parity error occurred at
the specified (hex) location.

Press F1

ROM at xxxx (LENGTH yyyy) with
nonzero checksum (zz)

An illegal adapter ROM was
located at the specified
address.

Check the external adapter (such as a
video card) to determine if it is
causing the conflict.

Time/Date corrupt - run SCU The time and date stored in the
real-time clock have been
corrupted, possibly by a power
loss.

1. Run Computer Setup.
2. If problem persists, replace

auxiliary battery.
3. If problems persists, replace

system board.
Unexpected amount of memory, run
SCU

The amount of memory
detected by POST does not
match the amount specified in
CMOS RAM.

Run Computer Setup.

Hard disk xx failure (or error) A failure or an error occurred
when trying to access the hard
drive.

1. Run Scan disk.
2. Check disk in DOS and

Windows 95 or later.
3. If problem persists, refer to

Table 2-10.
Unsupported memory module An EDO memory module was

installed in the memory
expansion slot.

Remove the EDO memory module
and replace with SDRAM memory
module.
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Fatal errors emit a beep and may display a FATAL message. Fatal errors indicate
severe problems, such as a hardware failure. Fatal errors do not allow the system to
resume. Some of the Fatal error beep codes are listed at the end of this section.

Table 2-2
Fatal Error Messages

Message Description Beep Code

CMOS RAM test failed A walking bit test of CMOS RAM location 0E
(Hex) - 3F (Hex) failed.

3

DMA controller faulty A sequential read/write of the transfer count
and transfer address registers within the
primary and secondary DMA controllers failed.

4

Faulty DMA page registers A walking bit read/write of the 16 DMA
controller page registers starting at location
80 Hex failed.

0

Faulty refresh circuits A continuous read/write test of port 61h found
that bit 4 (Refresh Detect) failed to toggle
within an allotted amount of time.

1

Interrupt controller failed A sequential read/write of various Interrupt
Controller registers failed.

5

ROM checksum incorrect A checksum of the ROM BIOS does not match
the byte value at F000:FFFF.

2

RAM error at location xxxx RAM error occurred during memory test. None

Table 2-3
Fatal Error Beep Codes

Beep Code Beep Sequence Description Recommended Action

0 S-S-S-P-S-S-L-P The DMA page registers are
faulty.

Replace system board.

1 S-S-S-P-S-L-S-P The refresh circuitry is faulty.
2 S-S-S-P-S-L-L-P The ROM checksum is incorrect.
3 S-S-S-P-L-S-S-P The CMOS RAM test failed.
4 S-S-S-P-L-S-L-P The DMA controller is faulty.
5 S-S-S-P-L-L-S-P The interrupt controller failed.
6 S-S-S-P-L-L-L-P The keyboard controller failed.
7 S-S-L-P-S-S-S-P Graphics adapter is faulty.
8 S-S-L-P-S-S-L-P Internal RAM is faulty. Replace memory board or

system board if memory on
system board is faulty.

S = Short, L = Long, P = Pause
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2.5  Compaq Utilities

Compaq Utilities contain several functions that

■ Determine if various computer devices are recognized by the system and are
operating properly.

■ Provide information about the system after it is configured.

Compaq Utilities include the following programs:

■ Computer Setup

■ Computer Checkup (TEST)

■ View System Information (INSPECT)

To access Compaq Utilities:

1. Turn on or restart the computer by clicking Start ⇒ Shut Down ⇒ Restart the
computer.

2. Press F10 when the blinking cursor appears in the upper-right corner of the display.
3. Select a menu option.

2.5.1 Computer Setup
Computer Setup contains utilities that give you an overall picture of the computer
hardware configuration and aid in troubleshooting. These utilities also allow you to set
custom features such as security options, power conservation levels, and startup
preferences.

If you are running Windows 95 or later, the computer automatically recognizes and
configures the system for new devices. If you have a configuration problem, or want to
view or reset configuration settings, you can use Computer Setup.

NOTE:  If you are running Windows 95 or later, you should use Computer Setup only to
adjust system features such as battery conservation level. Windows 95 or later may
override other configuration changes.

If you are running Windows NT, the computer does not automatically recognize new
devices added to the system. All devices ordered with your system have been
configured for you. Use Computer Setup to view settings for a new device you have
added or to reset configuration settings for preinstalled devices.

Computer Setup provides two methods of viewing the computer configuration:  by type
(factory setting) or connection.
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Categories by type:

■ System features—security, power, boot management

■ Communication—port, modem, and other communication devices

■ Storage—storage-related devices such as hard drive, CD-ROM drive, DVD-ROM
drive, diskette drive

■ Input devices—keyboard, mouse, and other input devices

■ Network—network adapter or other network-related devices

■ Audio—sound properties and audio device settings

■ Video—display timeouts and video device resources

■ Other—miscellaneous devices

Categories by connection:

■ System features—security, power, boot management

■ System devices—keyboard, mouse, parallel and serial ports

■ ISA—ISA bus and connected devices

■ PCI—PCI bus and connected devices

■ PC Card—PC Card devices

Running Computer Setup
1. Turn on or restart the computer by clicking Start ⇒ Shut Down ⇒ Restart the

computer.
2. Press F10 when the blinking cursor appears in the upper-right corner of the screen.
 NOTE:  If your a setup password is enabled, it must be used to access Computer

Setup.
3. Click a language and press Enter.
4. Click Computer Setup and press Enter.
5. When you are finished, click Exit.

Exiting Computer Setup
1. Click Exit.
2. Select one of the following Exit options:

■ Save—Saves the new settings and exits Computer Setup.

NOTE:  Some settings may not take effect until the computer is restarted.
■ Ignore—Exits Computer Setup and restores previous settings.

■ Cancel—Returns to Computer Setup.
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2.5.2 Computer Checkup (TEST)
Computer Checkup (TEST) determines whether the various computer components and
devices are recognized by the computer and are functioning properly. You can display,
print, or save the information that Computer Checkup generates.

NOTE:  Compaq Utilities are intended for testing only Compaq-supplied components.
Testing non-Compaq components may be inconclusive.

Running Computer Checkup (TEST)
1. Plug the external power supply into the computer. A low battery condition can

interrupt the program.
2. Connect a printer if you want to print a log of error messages.
3. Turn on the external devices that you want to test.
4. Turn on or restart the computer.
5. Access Compaq Utilities by pressing F10 when the blinking cursor appears in the

upper-right corner of the display.
6. Click Computer Checkup ⇒ View the Device List.

■ If the list of installed devices is correct, click OK.

■ If the list is incorrect, ensure that any new devices are installed properly.

7. Select one of the following from the Test Option menu:

■ Quick Check Diagnostics

■ Automatic Diagnostics

■ Prompted Diagnostics

8. Follow the instructions on the screen as the devices are tested.
9. Click Exit Diagnostics ⇒ Exit from this utility.
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Computer Checkup (TEST) Error Codes
Computer Checkup (TEST) error codes occur if the system recognizes a problem while
running Computer Checkup. These error codes help identify possible defective
assemblies. Table 2-4 through Table 2-14 list Computer Checkup error codes, a
description of the error condition, and the recommended action for resolving the
condition. For removal and replacement procedures, refer to Chapter 5, “Computer
Removal and Replacement Procedures.”

IMPORTANT:  Run Computer Checkup each time you complete a recommended action
step. If the problem is resolved when POST and Computer Checkup are rerun (in other
words, with no error codes), do not perform the remaining recommended action steps.

NOTE:  The error codes in the following tables are listed in an “AYE-XX” format,
where:

A or AA = Number that represents the faulty assembly

 YY = Test or action that failed

 XX = Specific problem

Table 2-4
Processor Test Error Codes

Error Code Description Recommended Action

101-xx CPU test failed. Replace the processor board and retest.
103-xx DMA page registers test failed. Replace the system board and retest.
104-xx Interrupt controller master test failed.
105-xx Port 61 error.
106-xx Keyboard controller self-test failed.
107-xx CMOS RAM test failed.
108-xx CMOS interrupt test failed.

109-xx CMOS clock test failed.

110-xx Programmable timer load data test failed.
113-xx Protected mode test failed.

Table 2-5
Memory Test Error Codes

Error Code Description Recommended Action

200-xx Memory machine ID test failed. The following steps apply to error codes 200-xx
and 202-xx:

202-xx Memory system CMOS checksum failed. 1. Flush the system CMOS and retest. See note.
2. Replace the system board and retest.

203-xx Write/Read test failed. The following applies to error codes 203-xx
through 215-xx:

204-xx Address test failed. Remove and replace the SODIMM memory board
or system board (if the memory on the system
board is faulty) and retest.

211-xx Random pattern test failed.
214-xx Noise test failed.

215-xx Random address test failed.
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Table 2-6
Keyboard Test Error Codes

Error Code Description Recommended Action

300-xx Failed ID Test 1. Reseat the keyboard assembly.
301-xx Failed Self Test/Interface Test 2. Replace the keyboard and retest.
302-xx Failed Individual Key Test 3. Replace the system board and retest.
304-xx Failed Keyboard Repeat Test

Table 2-7
Parallel Printer Test Error Codes

Error Code Description Recommended Action

401-xx Printer failed or not connected. 1. Connect the printer.
402-xx Failed Port Test 2. Check power to the printer.
403-xx Printer pattern test failed. 3. Use Compaq Utilities to test port.

4. Check port and IRQ configuration.
5. Replace the system board and retest.

NOTE:  Fn+F11 clears the ESCD configuration information. If the Fn+F11 sequence is
pressed very early after powering the machine on (after you see the keyboard LEDs
blink, but before the video is initialized), CMOS memory will be invalidated. The
ESCD is cleared, the machine is reset and boots with the "162 - System Options Not
Set" message. This is a way to clear out configuration information, such as the
Windows 95 or later knowledge about a docking station. It may help clear up problems
if the configuration information has been corrupted. Timing of this keystroke sequence
is critical, because there is a very narrow window during which the keys will be
recognized. These keys are not documented to end users.
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Table 2-8
Diskette Drive Error Codes

Error Code Description Recommended Action

600-xx Diskette ID drive types test
failed.

The following steps apply to error codes 600-xx
through 698-xx:

601-xx Diskette format failed. 1. Replace the diskette.
602-xx Diskette read test failed. 2. Replace the diskette drive and retest.
603-xx Diskette write/read/compare test failed. 3. Replace the system board and retest.
604-xx Diskette random read test failed.
605-xx Diskette ID media test failed.
606-xx Diskette speed test failed.
609-xx Diskette reset controller test failed.
610-xx Diskette change line test failed.
697-xx Diskette type error
698-xx Diskette drive speed not within limits.
699-xx Diskette drive/media ID error 1. Replace media.

2. Run Compaq Utilities.

Table 2-9
Serial Test Error Codes

Error Code Description Recommended Action

1101-xx Serial port test failed. 1. Check port configuration.

2. Replace the system board and retest.

Table 2-10
Hard Drive Test Error Codes

Error Code Description Recommended Action

1701-xx Hard drive format test failed. 1. Run Compaq Utilities and verify drive type.

1702-xx Hard drive read test failed. 2. Verify that all secondary drives have
secondary drive capability.

1703-xx Hard drive write/read/compare test failed. 3. Replace the hard drive and retest.

1704-xx Hard drive random seek test failed. 4. Replace the system board and retest.

1705-xx Hard drive controller test failed.
1706-xx Hard drive ready test failed.
1707-xx Hard drive recalibration test failed.
1708-xx Hard drive format bad track test failed.
1709-xx Hard drive reset controller test failed.
1710-xx Hard drive park head test failed.
1715-xx Hard drive head select test failed.
1716-xx Hard drive conditional format test failed.
1717-xx Hard drive ECC* test failed.
1719-xx Hard drive power mode test failed.
1724-xx Network preparation test failed.
1736-xx Drive monitoring test failed.

* ECC = Error Correction Code
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Table 2-11
Video Test Error Codes

Error Code Description Recommended Action

501-xx Video controller test failed. The following actions apply to error codes 501-xx
through 516-xx:

502-xx Video memory test failed. 1. Disconnect external monitor and test with
internal LCD display.

503-xx Video attribute test failed. 2. Replace the display assembly and retest.
504-xx Video character set test failed. 3. Replace the system board and retest.
505-xx Video 80 × 25 mode 9 × 14 character

cell test failed.
506-xx Video 80 × 25 mode 8 × 8 character

cell test failed.
507-xx Video 40 × 25 mode test failed.
511-xx Video screen memory page test failed.
512-xx Video gray scale test failed.
514-xx Video white screen test failed.
516-xx Video noise pattern test failed.
2402-xx Video memory test failed. The following actions apply to error codes

2402-xx through 2456-xx:
2403-xx Video attribute test failed. 1. Run Compaq Utilities.
2404-xx Video character set test failed. 2. Disconnect external monitor and test with

internal LCD display.
2405-xx Video 80 × 25 mode 9 × 14 character cell

test failed.
3. Replace the display assembly and retest.
4. Replace the system board and retest.

2406-xx Video 80 × 25 mode 8 × 8 character cell
test failed.

2411-xx Video screen memory page test failed.
2412-xx Video gray scale test failed.
2414-xx Video white screen test failed.
2416-xx Video noise pattern test failed.
2418-xx ECG/VGC memory test failed.
2419-xx ECG/VGC ROM checksum test failed.
2421-xx ECG/VGC 640 × 200 graphics mode test

failed.
2422-xx ECG/VGC 640 × 350 16 color set test

failed.
2423-xx ECG/VGC 640 × 350 64 color set test

failed.
2424-xx ECG/VGC monochrome text mode test

failed.
2425-xx ECG/VGC monochrome graphics mode test

failed.
2431-xx 640 × 480 graphics test failed.
2448-xx Advanced VGA Controller test failed.

Continued
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Table 2-11  Video Test Error Codes  Continued

Error Code Description Recommended Action

2451-xx 132-column Advanced VGA test failed.
2456-xx Advanced VGA 256 Color test failed.
2458-xx Advanced VGA Bit BLT test failed. The following step action to error codes 2458-xx

to 2480-xx:
2468-xx Advanced VGA DAC test failed. Replace the system board and retest.
2477-xx Advanced VGA data path test failed.

2478-xx Advanced VGA Bit BLT test failed.
2480-xx Advanced VGA Linedraw test failed.

Table 2-12
Audio Test Error Codes

Error Code Description Recommended Action

114-01 Speaker test failed. 1. Check system configuration.
2. Verify that the audio/led board is properly

seated.
3. Verify display audio cable connection.

3206-xx Audio System Internal Error Replace the audio board and retest.

Table 2-13
Pointing Device Interface Test Error Codes

Error Code Description Recommended Action

8601-xx Pointing device test failed. Replace the keyboard/CPU cover assembly.
8602-xx Interface test failed.

Table 2-14
CD-ROM Drive Test Error Codes

Error Code Description Recommended Action

3301-xx CD-ROM drive read test failed. 1. Replace the CD and retest.
2. Verify that drivers are loaded and properly

installed.
3305-xx CD-ROM drive seek test failed. 3. Replace the CD-ROM drive and retest.

4. Replace the system board and retest.
6600-xx ID test failed.

6605-xx Read test failed.

6608-xx Controller test failed.
6623-xx Random read test failed.
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2.5.3 Running View System Information (INSPECT)
The View System Information (INSPECT) utility provides information about the
computer and installed or connected devices. You can display, print, or save the
information.

To access the INSPECT utility:

1. Connect a printer if you want to print the INSPECT information.
2. Turn on or restart the computer.
3. Access Compaq Utilities by pressing F10 when the cursor blinks in the upper-right

corner of the display.
4. If prompted, select a language.
5. Click View System Information (INSPECT).
6. Click the item you want to view. The list includes:

■  System ■  Audio
■  ROM ■  Operating system
■  Keyboard ■  System files
■  System ports ■  Windows files
■  System storage ■  Miscellaneous
■  Graphics
■  Memory

■  Network (applicable only if
computer is docked in the
Convenience Base II)

7. Follow the instructions on the screen to cycle through the screens, to return to the
list and choose another item, or to print the information.

8. Select Exit Inspect.
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2.5.4 Running Compaq Diagnostics
Compaq Diagnostics provides computer component information when the operating
system is working.

If you are running Windows 95 or later, access Compaq Diagnostics for Windows by
double-clicking My Computer ⇒ Control Panel ⇒ Compaq Diagnostics.

2.5.5 Boot Sequencing
1. Run Computer Setup.
2. Click the System Features icon ⇒ Boot Management box ⇒ MultiBoot tab.
3. Designate the hard drive boot (startup) sequence you want.
4. Click OK to accept the changes.

2.5.6 Factory Default Settings

Table 2-15
Factory Default Settings

Initialization

Enable POST Memory Test Checked (enabled)
Keyboard NumLk Unchecked (Off)

1 Hard drive in the computer
2 Hard drive in the computer MultiBay

Boot display Auto
Language Language of country

Ports

Serial ports

Serial port 3F8, IRQ4
Unassigned 2F8, IRQ3

Parallel port 378, IRQ7
Ethernet port 300, IRQ9

Continued 
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Table 2-15  Factory Default Settings  Continued

Power
Low Battery Warning Beep Checked (enabled)
External Energy-Saving Monitor Connected Unchecked (not connected)
Power Management

Enabled While operating power on battery
Conservation Level Medium
Level Definition

High Suspend Time:  5 minutes
Hibernation Timeout:  Immediate
Drive Timeout:  2 minutes
Screen Timeout:  2 minutes

Medium Suspend Time:  10 minutes
Hibernation Timeout:  1 hour
Drive Timeout:  6 minutes
Screen Timeout:  4 minutes

Custom Suspend Time:  disabled
Hibernation Timeout:  low battery
Drive Timeout:  always on
Screen Timeout:  always on

Security
Enable QuickLock/QuickBlank Unchecked (Disabled)
Enable Power-On Password Unchecked (Disabled)
Disable Serial/Infrared Ports Unchecked (Enabled)
Disable Parallel Port Unchecked (Enabled)
Disable PC Card Slots Unchecked (Enabled)
Setup Password Password blank
Power-On Password Password blank
Diskette Drives

Disable Diskette Drives Unchecked (Enabled)
Disable Diskette Boot Unchecked (Enabled)
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2.6  Troubleshooting Without Diagnostics

This section provides information about how to identify and correct some common
hardware, memory, and software problems. It also explains several types of messages
that may be displayed on the screen.

Since symptoms can appear to be similar, carefully match the symptoms of the
computer malfunction against the problem description in the Troubleshooting tables to
avoid a misdiagnosis.

2.6.1 Before Replacing Parts
When troubleshooting a problem, check the following items for possible solutions
before replacing parts:

■ Verify that cables are connected properly to the suspected defective parts.

■ Verify that all required device drivers are installed.

■ Verify that all printer drivers have been installed.

2.6.2 Checklist for Solving Problems
If you encounter a minor problem with the computer or software applications, go
through the following checklist for possible solutions:

■ Is the computer connected to an external power source, or does it have a fully
charged battery pack installed?

■ Are all cables connected properly and securely?

■ Did the diskette drive contain a nonbootable diskette when you turned on the
computer?

■ Have you installed all the needed device drivers? For example, if you are using a
mouse, you may need to install a mouse device driver.

■ Are printer drivers installed?

Eliminating the typical problems described in this Troubleshooting section may save
you time and money. If the problem appears related to a software application, check the
documentation provided with the software. You may discover something you can easily
resolve by yourself.
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Solving Audio Problems

Table 2-16
Solving Audio Problems

Problem Probable Cause Recommended Action(s)

Computer does not beep after
the Power-On Self-Test
(POST).

Speaker volume has been
turned down.

Adjust the volume with the volume control
buttons located at the top-right corner of the
computer.

Computer beeped five times
and battery light is blinking.

Computer has entered a
low-battery condition.

Immediately save open files and resolve the
low-battery condition.

Computer does not beep to
indicate a low-battery
condition.

Low-battery warning beeps
have been turned off.

Enable low-battery warning beeps in
Windows 95 or later Power Properties or in
Computer Setup power management.

System beeps have been
turned down too low.

Press Fn+F5, then press the right arrow key
to increase the volume of the system beeps.

Audio playback is too low or
too loud.

The computer volume control
and/or the software volume
control needs to be adjusted.

In Windows 95 or later, adjust the computer
volume control buttons and adjust the
volume control in Multimedia Properties.
NOTE: The volume control in Multimedia
Properties only affects the “Wave” audio
sources such as system sounds and *.wav
file playback. To change other sources such
as MIDI, video sound, and game effects, use
the Volume Control application in
accessories/Multimedia.
In Windows NT, adjust the multimedia
volume control under the Accessories
folder.

Internal speakers produce no
sound.

Volume has been muted. Press the increase volume control button to
increase the volume. Press Fn+F5, then
press the right arrow key to increase the
volume of the system beeps.

External speakers or
headphones are connected to
the computer.

Use the external speakers or headphones or
use the Convenience Base II speakers.

To use the internal speakers, disconnect the
external speakers or headphones or undock
the computer.

Speaker wires are not
connected.

Make sure the speaker wires are connected
properly.

Speakers are bad. Replace the speakers.
Continued
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Table 2-16  Solving Audio Problems  Continued

Problem Probable Cause Recommended Action(s)

Internal speaker does not
produce sound when an
external audio source is
connected to the stereo
line-in jack.

Volume may be turned off or
set too low.

■ Adjust the volume control located at
the top-right corner of the computer.

■ Use the volume control and mixing
features available in Control Panel ⇒
Multimedia.

■ Adjust the volume using the speaker
icon on the taskbar.

Line input may not be
connected properly.

Check line input connection.

Headphones or speakers are
connected to the stereo
speaker/headphone jack,
which disables the internal
speakers.

Disconnect the headphones or speakers to
enable the internal speakers.

External microphone does
not work.

The wrong type of
microphone or microphone
plug is being used.

Check to see if a monophonic electric
condenser microphone with a 3.5-mm plug
is being used.

The microphone may not be
connected properly.

Ensure that the microphone plug is properly
connected to the mono microphone jack.

Sound source is not selected. Ensure that microphone is selected as the
recording source in Control Panel ⇒
Multimedia and that the recording level is
adjusted.

No sound from game
program

Audio settings are not set
correctly.

Check the game program audio settings.

Computer volume control is
turned down.

Adjust the volume with the volume control
buttons located at the top right corner of
the computer.

Headphones are connected. Use or disconnect the headphones.
No sound from headphones Volume or mixing controls set

incorrectly.
■ Adjust the volume with the volume

control buttons located at the top right
corner of the computer.

■ Use the volume control and mixing
features available in Control Panel ⇒
Multimedia.

Sound source not selected. Verify that the sound source is selected in
Control Panel ⇒ Multimedia.

Volume or mixing controls set
incorrectly.

■ Adjust the volume with the volume
control buttons located on the right
side of the computer.

■ Check the volume and mixer controls
in Control Panel ⇒ Multimedia.
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Solving Battery Problems
The following table lists some common battery problems and recommended actions to
take when they occur. The "Solving Power Problems" section in this chapter also may
be applicable.

Table 2-17
Solving Battery and Battery Gauge Problems

Problem Probable Cause Recommended Action(s)

The computer turns on the
first time it is used, but the
battery does not charge.

The battery pack is in
ship mode.

Remove and reinsert the battery pack.

Computer does not turn on
when battery pack is inserted
and power cord is unplugged.

Battery is discharged. Ensure that the battery  pack is
properly installed.
Connect the computer to an external power
source and charge the battery pack.
Replace the battery pack with a fully charged
battery pack.
Check battery status by pressing Fn+F8.

Computer beeped five times
and battery light is blinking.

Computer has entered a
low-battery condition.

Immediately save any open file(s). Then do
one of the following:
1. Connect the computer to an external

power source.
2. Turn the computer off and replace the

battery pack.
Computer battery light blinks
to indicate low-battery
condition, but computer does
not beep.

Low-battery beeps were
turned off.
Volume is turned off or turned
down too low.

Run Computer Setup and turn on the low
battery warning beeps.
Press Fn+F5 to adjust the volume of the
system warning beeps.

Battery light does not turn on
to indicate battery pack Is
charging.

Battery pack is already
charged.
Battery pack was exposed to
temperature extremes.

No action is necessary.

Allow time for the battery pack to return to
room temperature.

Battery pack is at the end of
its life.

Replace the battery pack.

Battery pack is warm to the
touch after charging.

Warming occurs during
charging.

No action is required.

Continued
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Table 2-17  Solving Battery and Battery Gauge Problems  Continued

Problem Probable Cause Recommended Action(s)

Computer turned off and
information in memory was
lost when the battery pack
was replaced.

Hibernation was disabled,
Suspend was not initiated, or
AC power was not connected
before the discharged battery
pack was removed.

To prevent loss of information next time,
initiate Suspend, enable Hibernation, or
connect AC power before changing
batteries..

You have to set the date and
time every time you turn on
the computer.

Real-time clock (RTC) battery
is at the end of its life.

Replace the RTC battery.

Battery pack charge does not
last as long as expected.

Battery pack is being exposed
to high temperatures or
extremely cold temperatures.

Keep the battery pack within the
recommended operating temperature range
50°F to 95°F (10°C to 35°C) or
recommended non-operating range -22°F
to 140°F (-30°C to 60°C ). Recharge the
battery pack.

Battery pack has partially
self-discharged.

If the computer is disconnected from the
external power for more than two weeks,
remove the battery pack to reduce the self-
discharge rate.

Power management is
disabled.

Press Fn+F7 and set the power
conservation level.

An external device or PC Card
is draining the battery.

Turn off or disconnect external devices
when not using them.

Computer is beeping and
battery power light is blinking.

Battery pack charge is low. Do one of the following:

■ Charge the battery pack.

■ Replace the battery pack.

■ Connect the computer to an external
power source.

■ Initiate Hibernation.

Solving CD-ROM Drive or DVD-ROM Drive Problems

Table 2-18
Solving CD-ROM Drive or DVD-ROM Drive Problems

Problem Probable Cause Recommended Action(s)
Cannot read a compact disc. Compact disc is not properly

seated in the drive.
Open the CD loading tray, lay the compact
disc on it, then close the tray.

Compact disc is loaded in the
CD loading tray upside down.

Open the CD loading tray, turn over the
compact disc (label facing up), then close
the tray.

Compact disc has a scratch on
its surface.

Insert a different compact disc.

Drive is not recognized by the
computer.

Drive is not connected
properly.

Turn off the computer, remove the drive and
reinsert it.



Troubleshooting    2-23

Solving Diskette and Diskette Drive Problems

Table 2-19
Solving Diskette and Diskette Drive Problems

Problem Probable Cause Recommended Action(s)

Diskette drive cannot read a
diskette.

Diskette media has a bad
sector.

Copy remaining files to the hard drive or
another formatted diskette. Reformat the
diskette.

Using the wrong diskette type
for the diskette drive type.

Use the required diskette type.

Diskette is not formatted. Format the diskette.
If you are using Windows 95 or later:

1. From the Windows 95 or later desktop,
double-click My Computer.

2. Click 3 ½ Floppy (A:) ⇒ File ⇒ Format.

3. Fill in the appropriate information, then
click Start.

If you are using Windows NT, format the
diskette by entering format a: at the system
prompt.

Diskette drive cannot write to
a diskette.

Diskette is not formatted. Format the diskette.
If you are using Windows 95 or later:

1. From the Windows 95 or later desktop,
double-click My Computer.

2. Click 3 ½ Floppy (A:) ⇒ File ⇒ Format.

3. Fill in the required information, then click
Start.

If you are using Windows NT, format the
diskette by entering format a: at the system
prompt.

Diskette is write-protected. Use another diskette that is not
write-protected or disable the write-protect
feature.

Writing to the wrong drive. Check the drive letter in your path
statement.

Not enough space is left on
the diskette.

Save the information to another diskette.

Disable diskette write ability
is turned on.

Run Computer Setup. Click on the Storage
icon. Make sure Disable diskette write
ability is not checked.
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Solving Hard Drive Problems

CAUTION:  To prevent loss of information, always maintain an up-to-date backup of the
hard drive.

Table 2-20
Solving Hard Drive Problems

Problem Probable Cause Recommended Action(s)

Cannot access hard drive. Hard drive is not seated. Shut down the computer, remove and
reinsert the hard drive, then turn on the
computer.

Hard drive was inserted while
computer was on, in Suspend,
or in Hibernation.

Shut down the computer, then turn it on
again to initialize it during power on.

Hard drive may be damaged. Try inserting another hard drive.

Reading hard drive takes an
unusually long time after
restarting the computer.

Hibernation was initiated and
system is now exiting from it.

Give the system time to restore the
previously saved data.

Hard drive error occurs. Hard drive has bad sectors or
has failed.

Do one of the following:

■ If you are running Windows 95 or later,
access ScanDisk by clicking Start ⇒
Programs ⇒ Accessories ⇒ System
Tools ⇒ ScanDisk, then check the
Automatically fix errors box. Click Start
to begin scanning.

If you are running Windows NT, go to
the system prompt and type chkdsk to
scan for errors.

■ Reformat the hard drive.

■ Contact your Compaq authorized dealer,
reseller, or service provider or Compaq
customer support for assistance.

Hard drive error occurs. Hard drive may be damaged. Try inserting another removable drive, if the
hard drive is in the MultiBay.

Errors occur after starting
from an additional hard
drive.

Additional hard drive does not
have the software and drivers
necessary to boot and operate
correctly.

Boot from the hard drive supplied with the
computer or another hard drive that has the
necessary software and drivers.

Hard drive does not work. Hard drive is not seated. Turn off and unplug the computer, remove
the hard drive, then reinsert it.
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Solving Hardware Installation Problems

Table 2-21
Solving Hardware Installation Problems

Problem Probable Cause Recommended Action(s)

New device is not
recognized as part of
the computer system.

The system did not
automatically configure the
new device.

In Windows 95 or later, double-click the Add
New Hardware icon in Control Panel.

Refer to the documentation that came with
the new device for installation instructions.

Cable(s) of new external
device are loose or
power cables are
unplugged.

Ensure that all cables are properly and
securely connected and the power cord is
plugged into an electrical outlet.

Power switch of new
external device is not turned
on.

1. Turn off the computer.
2. Turn on the external device.
3. Turn on the computer to integrate the

device with the computer system.
New device is not
configured for Windows NT.

Use Computer Setup to view settings for
the new device or to reset the
configuration settings for preinstalled
devices.
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 Solving Modem Problems

Table 2-22
Solving Modem Problems

Problem Probable Cause Recommended Action(s)

Modem loses connection. The connection from the
phone line to the modem is
loose.

Check to make sure the telephone cable is
properly connected.

Call Waiting has not been
disabled.

Disable Call Waiting.
1. Click Start ⇒ Control Panel ⇒

double-click Modems.
2. From the General tab of the Modems

Properties page, click Dialing Properties.
3. From the My Locations tab of the Dialing

Properties page, check the box labeled
This location has call waiting. Select *70,
70#, or 1170 from the drop-down list to
disable call waiting for your dialing area.

Noisy telephone line Phone line noise causing
garbled or missing characters,
or slow data transfer speeds.

Check your telephone and modem cable
connections. If they are a little loose, they
can cause noise on the line.
Check with your local telephone company for
a phone line filter.

Phone line noise causing a
disconnection.

Hang-up Delay S Register
(S10) set too low.

Change S10 default to 150.
1. Click Start ⇒ Programs ⇒

Accessories ⇒ HyperTerminal.
2. Go to Command Mode.
3. Type ATS10=150 and press Enter.
This command causes the modem to take
longer to disconnect even if there is noise
on the line.

Continued
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Table 2-22  Solving Modem Problems  Continued

Problem Probable Cause Recommended Action(s)

No dial tone Phone service is not
connected to the telephone
wall jack.

Verify service from the local phone
company:
1. Unplug the telephone cable from the

telephone wall jack.
2. Connect a telephone to the jack, pick up

the handset, and listen for a dial tone. If
there is a dial tone, reconnect the
modem to the telephone wall jack with
the telephone cable and make sure all
connections are secure.

3. If there is still no dial tone, contact your
local phone company or building
manager.

The modem is not responding
to commands from the
computer keyboard.

Verify that the modem and computer are
connected:
1. Click Start ⇒ Programs ⇒

Accessories ⇒ HyperTerminal.
2. Go to Terminal Mode, then type AT and

press the Enter key.
3. If the modem displays OK, the modem

and computer are working together. If
the modem displays ERROR, or does not
respond, restart the computer and repeat
step 1.

4. Type ATDT and listen for a dial tone.
5. Type ATH0 (zero) to hang up.

Speaker Control AT Command
(ATM) is set to 0.

Set the Speaker Control to 1:
1. Click Start ⇒ Programs ⇒

Accessories ⇒ HyperTerminal.
2. Go to Command Mode, type ATM1 and

press Enter.
3. Type ATH1 and listen for a dial tone.
4. Type ATH0 (zero) to hang up.

The modem is plugged into a
digital PBX line rather than an
analog line.

Plug the modem into an analog line. If you
are in an office, the analog line is often the
one connected to a fax machine or modem.
To get an analog line in a hotel, request a
room with a “data” line.

Characters are garbled and
transfer rates are slow.

There is noise in the
telephone line.

■ Check your telephone and modem
cable connections. If they are loose,
they can cause noise on the line.

■ Check with your local telephone
company for a phone line filter.

Continued
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Table 2-22  Solving Modem Problems  Continued

Problem Probable Cause Recommended Action(s)

Ten-digit dialing does not
work correctly under
Windows 95 or later.

Ten-digit dialing doesn’t work
correctly under Windows 95 or
later, making it difficult to dial
numbers in a different area
code that are not long
distance calls.

Since Windows 95 or later does not limit the
number of digits you can enter in the Phone
Number field, set the Area Code field to
match your local area code. Then type the
ten-digit telephone number in the Phone
Number field.

Modem cable
disables/interferes with other
telephony devices (Germany,
Austria, and Switzerland only).

The modem cable does not
provide the additional 4-wire
connection required in
Germany, Austria, and
Switzerland to form the serial
pass-through necessary so
that other devices can work on
the same phone line.

To use another telephony device on the
same line in these countries, unplug the
modem cable from the wall jack first.

Modem does not dial correctly
under Windows 95 or later
(Switzerland and Germany
only).

The “Wait for dial tone before
dialing”  check box is checked.
This causes Windows 95 or
later to issue an ATDT;
command. A typical dial string
would look like this:
ATDT;
ATDTnnn-nnnn
In Germany and Switzerland,
the ‘ ;’  dial modifier is not
permitted to be used in this
fashion by regulatory agencies
since ATDT; takes the modem
off-hook without dialing.
Therefore, the modem returns
an error message when
attempting to dial. The error
message reads:
“The computer is not receiving
a response from the modem.
Check that the modem is
plugged in, and if necessary,
turn the modem off, then turn
it back on.”

1. Click Start ⇒ Settings ⇒ Control Panel.

2. Double-click the Modems icon.

3. Click the Properties button.

4. Select the Connection tab.

5. Click the “Wait for dial tone before
dialing”  check box to clear it.

6. Click OK ⇒ Close.
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Solving PC Card Problems

Table 2-23
Solving PC Card Problems

Problem Probable Cause Recommended Action(s)
Computer does not beep when
PC Card is inserted but PC
Card works correctly.

System beeps are turned
down.
PC Card sound effects have
been disabled.

Press Fn+F5, then press the right arrow key
to increase the system beeps volume.
In Windows 95 or later, double-click PC Card
icon ⇒ Global Settings tab. Deselect Disable
PC Card Sound Effects.

Computer does not beep when
PC Card is inserted and PC
Card does not work.

PC Card is not inserted
properly.
The PC Card slots have been
disabled.

Remove and reinsert the card gently to
avoid damaging the pins.
Run Computer Setup to enable the PC Card
slots. When the system starts, press F10
then select Computer Setup ⇒ Other
Devices ⇒ PC Card Controller ⇒ Resources.
Deselect the “Disabled” check box.
In Windows 95 or later, click Start ⇒
Settings ⇒ Control Panel ⇒ System ⇒
Device Manager ⇒ PCMCIA Socket. Double-
click the Texas Instruments TI-1131 CardBus
controller to view device properties. Deselect
the “Disable in this hardware profile” check
box.

Card or card driver is not
compatible with the computer
or with the operating system.

Contact service provider for a list of
compatible PC Cards.

Computer beeps twice, but
modem and/or fax does not
work.

Telephone cord is not plugged
in all the way.

Verify that the telephone connection is
secure.

The wrong COM port is being
used to access the card.

Verify the COM port assigned to the card and
within the application is correct.
In Windows 95 or later, click Start ⇒ Help
⇒ Contents ⇒ Troubleshooting ⇒ Problem.
Follow the instructions on the screen.

Computer beeps twice but
network card does not work.

Network server is unavailable. Contact system administrator.

Computer beeps twice when a
storage card is inserted, but
the card does not work.

The wrong drive letter is being
used to access the storage
card.

Open Windows Explorer and verify the drive
letter.

PC Card does not work Windows NT was running
when the PC Card was
inserted.

Turn off the computer and reinsert the PC
Card.
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Solving Power Problems

Table 2-24
Solving Power Problems

Problem Probable Cause Recommended Action(s)

Computer will not turn on. Computer is not connected to
a power source.

Insert battery pack or connect an external
power source.

Power cord to the external
power source is unplugged.

Ensure that power cord connecting the
computer and the external power source is
plugged in properly.

Battery pack is discharged. Insert a fully charged battery pack or connect
an external power source.

CMOS data is corrupt. Flush CMOS memory.
Computer will not turn on
when connected to external
power if battery pack is in the
computer.

Battery pack may be defective. Remove battery pack, insert another battery
pack, and try again.

Computer turned off while it
was left unattended and the
power/suspend light is off.

System initiated Hibernation
after a preset timeout.

Turn on the computer to restore information
at the point where Hibernation was
initiated.
NOTE: To change the Hibernation timeout
setting in Windows 95 or later, click the
Hibernation tab in Power Properties. In
Windows NT, run Computer Setup and
select Power Management.

Computer turned off while it
was left unattended and will
not turn on.

System initiated Hibernation
and/or shut down because of
a critical low-battery
condition.

Replace the battery pack with a fully charged
battery pack or connect an external power
source, then turn on the computer.

Computer initiated Suspend or
turned off when it was
docked.

The maximum operating
temperature was exceeded.

Computer is in a high temperature
environment and the fan is not able to cool
it. Let the computer cool down and turn it on
again.
Make sure the ventilation intake and exhaust
are not obstructed.

Hibernation does not work
properly.

Hibernation was not reset after
a memory upgrade.

Reset Hibernation in the Power Management
utility.

Computer does not turn on
when connected to external
power and no batteries are
installed.

Internal power supply is bad. Replace the internal power supply.
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Solving Display Problems
IMPORTANT:  Conduct all tests on a working monitor. If the recommended actions do
not solve the problem, replace the display. If the problem persists with a new display,
replace the system board.

Table 2-25
Solving Display Problems

Problem Probable Cause Recommended Action(s)

Characters are dim. The brightness or contrast
control (if applicable) is not
set properly.

Adjust the control(s) with the hotkeys:
Fn+F9 and Fn+F10.

Computer screen is in direct
light.

Tilt the display or move computer.

Display is damaged. Replace the display.
Screen is blank. QuickLock/QuickBlank was

initiated.
Enter the password to exit
QuickLock/QuickBlank.

Screen save was
initiated after the Power
Management timeout period.

Press any key or click the mouse.

Brightness or contrast needs
adjusting.

Adjust the control(s) with the hotkeys:
Fn+F9 and Fn+F10.

Screen has overheated. If computer is in direct sunlight, move it and
allow it to cool.

Computer screen is
blank and the screen on an
external monitor displays
information.

Display was switched to the
external monitor.

Press the Fn+F4 hotkeys to display
information on the computer screen.

Screen is blank and the
power/suspend light is
blinking.

System initiated Suspend. Press the suspend button to exit Suspend.
Enter the power-on password if prompted.

Screen is blank and the
power/suspend light and the
battery light are blinking.

System has entered a critical
low-battery condition.

Immediately connect the computer to an
external power source or replace the
battery pack.

Continued
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Table 2-25  Solving Display Problems  Continued

Problem Probable Cause Recommended Action(s)

External monitor does not
display information.

External monitor was
connected after the computer
was turned on.

Press the Fn+F4 hotkeys to switch to the
external monitor.

The external monitor signal
cable or power cord is not
properly connected.

Ensure that the cables are properly
connected.

Small red, green, or blue
spots appear on the
computer CTFT display.

Small spots, called on-pixels,
often appear on CTFT
screens. Compaq limits the
number of these on-pixels to
0.003 percent.

No action is required.

Display on an external
monitor is distorted.

Incorrect display device
drivers are installed or
incorrect resolution is set.

Double-click the Display icon in Control
Panel, click the Settings tab, and set the
correct display type and resolution for the
external monitor.

The external monitor is not
Energy Star compliant, but
monitor energy saving
feature is enabled.

Complete these steps:
1. Press any key or move the pointing

device to restore the display.
2. If display remains distorted, turn off the

monitor, then turn it on again.
3. Disable the monitor energy saving

feature in Display Properties or in
Computer Setup Power Management.

The image has a black
border and does not fill the
screen.

The Desktop Area setting is
smaller than the Resolution
setting.

Adjust the settings for the Desktop Area and
Resolution. Double-click Control Panel
Display ⇒ Settings ⇒ Compaq.
Press the Fn+T keys to expand the image.

Computer screen and
external monitor do not

Display was switched using
the hotkeys.

display information
simultaneously.

External monitor was not
turned on before the system
was turned on.

Initiate Suspend, connect the external
monitor, and turn on the monitor, then exit
Suspend.

External monitor was
connected after the computer
was turned on.

Initiate Suspend, connect the external
monitor, and turn on the monitor, then exit
Suspend.

Unrecognizable characters on
internal display or flashing
internal display when
connected to external
monitor.

Toggled to internal monitor
from an external monitor that
is using higher resolution
than that supported by the
computer.

Restart the system. If simultaneous display
is desired, use the resolution supported by
the computer.
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Solving USB Problems

Table 2-26
Solving USB Problems

Problem Probable Cause Recommended Action(s)

External device connected to
a USB connector does
not work.

The operating system limits
external devices connected
by USB to two tiers that can
include no more than two
hubs on the first tier and no
more than one keyboard and
one pointing device on the
first or second tier.

Reduce the number of connected external
USB devices to no more than two hubs on
the first tier, and no more than one keyboard
and one pointing device on the first or
second tier.

External device connected to a
USB connector does not work
during startup (before
Windows 95 or later loads).

During startup, only two tiers
are supported by the USB
connector. These tiers can
include no more than two
hubs on the first tier and no
more than one keyboard and
one pointing device on the first
or second tier.

■ Use the external device only after
Windows 95 or later has loaded.

■ Reduce the number of connected
external USB devices to no more than
two hubs on the first tier, and no more
than one keyboard and one pointing
device on the first or second tier.

External devices in lower
tiers do not work.

An unpowered hub is
connected to another
unpowered hub.

■ Use only powered hubs.

■ Make sure that all unpowered hubs are
immediately preceded by powered
hubs in the USB chain.

Solving Memory Problems
Some common causes and solutions for memory problems are listed in the following
table.

Table 2-27
Solving Memory Problems

Problem Probable Cause Recommended Action(s)

Memory count during POST
is incorrect

Optional memory expansion
board is installed incorrectly,
is incompatible with the
computer, or is defective

Ensure that the optional memory expansion
board is installed correctly

“Out of Memory” message is
displayed on the screen or
insufficient memory occurs
during operation.

System ran out of memory for
the application

■ Check the application documentation for
memory requirements

■ Install additional memory.

Too many terminate and stay
resident (TSR) applications
are running.

Remove from memory any TSR applications
that you do not need
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Solving Software Application Problems
Most software application or installation problems occur as a result of one or more of
the following:

■ The application was not installed correctly.

■ Memory was not allocated correctly.

■ A conflict exists between applications.

Table 2-28
Solving Software Application Problems

Problem Probable Cause Recommended Action(s)

Cannot use an application The application has not been
added to the PATH statement

Run the program with the full path name.

Insufficient memory to run
application

System ran our of memory for
the application

■ Check the application documentation for
memory requirements.

■ Install additional memory
Too many terminate and stay
resident (TSR) applications
are running.

Remove from memory any TSR applications
you do not need

Solving Keyboard and Mouse Problems

Table 2-29
Solving Keyboard Problems

Problem Probable Cause Recommended Action(s)

External keyboard does not
work

External keyboard may not be
securely connected ro may
be connected to an incorrect
external connector.

Ensure that the external keyboard is
properly and securely connected to the
external keyboard connector.

Table 2-30
Solving Mouse Problems

Problem Probable Cause Recommended Action(s)

External mouse does not work External mouse may not be
securely connected or may be
connected to an incorrect
external connector.

Ensure the external mouse is securely
connected to the mouse connector or the
correct external connector.

Mouse was connected after
system was turned on.

Turn off the unit, connect the mouse, and
turn the unit on to integrate the mouse.
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Solving External Device Installation Problems

Table 2-31
Solving External Device Installation Problems

Problem Probable Cause Recommended Action(s)

A new device is not
recognized as part of the
computer system

Power switch of the new
external device was not turned
on before the system was
turned on.

Initiate Suspend, ensure the external device
is connected properly, and turn on the
external device, then exit Suspend.
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chapter
 3 

ILLUSTRATED PARTS CATALOG 

This chapter provides illustrated parts and references for spare parts for the Armada 
1500c Series. To review an illustrated parts breakdown of the computer, refer to the 
Illustrated Parts Map that comes with this guide. 
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3.1  System Unit 

 

 

Figure 3-1. System Unit 
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Table 3-1 
System Unit  

Item Description Spares Part Number 

1 12.1-inch CSTN display assembly 105999-001 
* 12.1-inch CTFT display assembly 106001-001 

2 Keyboard  (US/Canada) 254968-001 
* Keyboard (Belgian) 254968-181 

* Keyboard (Brazilian) 254968-035 
* Keyboard (Danish) 254968-081 
* Keyboard (French) 254968-051 
* Keyboard (French Canadian) 254968-121 
* Keyboard (German) 254968-041 
* Keyboard (Italian) 254968-061 
* Keyboard (Japanese) 254968-191 
* Keyboard (Korean) 254968-033 
* Keyboard (Latin American Spanish) 254968-161 
* Keyboard (Norwegian) 254968-101 
* Keyboard (Portuguese) 254968-131 
* Keyboard (Spanish) 254968-071 
* Keyboard (Swedish/Finnish)  254968-091 
* Keyboard (Swiss)  254968-111 
* Keyboard (Taiwanese) 254968-034 
* Keyboard (UK English) 254968-031 

3 Top cover assembly 401108-001 

4 Base enclosure assembly 401101-001 

*  Not illustrated 
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3.2  Mass Storage and DualBay Devices 

 

 

Figure 3-2. Mass Storage Devices and DualBay Devices 
 

 

Table 3-2 
Mass Storage Devices and DualBay Devices 

Item Description Spares Part Number 

1 24x CD-ROM drive 401102-001 

* DVD-ROM drive 401097-001 

2 4.0-GB hard drive 310344-001 

* 5.0-GB hard drive 310364-001 

* 6.0-GB hard drive 310365-001 

 10.0-GB hard drive 102139-001 

3 1.44-MB, diskette drive 254962-001 

4 Lithium Ion battery pack 107163-001 

 * Nickel Metal Hydride battery pack 107150-001 

*  Not illustrated 
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3.3  Cables and Power Cords 

 

 

Figure 3-3. Cables and Power Cords 
 

 

Table 3-3 
Cables and Power Cords 

Item Description Spares Part Number 

1 CD-ROM/DVD-ROM cable (part of base enclosure assembly) 4011101-001 

2 Modem cable  165224-001 

3 6’ AC Power cord (US/Canada) 246959-001 
* 6’ AC Power cord (Australia/New Zealand) 246959-011 

* 6’ AC Power cord (Denmark) 246959-081 
* 6’ AC Power cord (Europe) 246959-021 
* 6’ AC Power cord (Italy) 246959-061 
* 6’ AC Power cord (Japan) 246959-291 
* 6’ AC Power cord (Korea) 246959-AD1 
* 6’ AC Power cord (Swiss)  246959-111 
* 6’ AC Power cord (UK) 246959-031 

4 RTC Battery 254971-001 

5 Microphone (part of plastics kit)  254981-001 

6 External AC adapter (includes DC power cord)  401095-001 

*  Not illustrated 
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3.4  Standard and Optional Boards 

 

 

Figure 3-4. Standard and Optional Boards 
 

 

Table 3-4 
Standard and Optional Boards 

Item Description Spares Part Number 

1 Memory board (SODIMM), 16-MB, 66 MHz, SDRAM 313917-001 

* Memory board (SODIMM), 32-MB, 66 MHz, SDRAM 313911-001 

* Memory board (SODIMM), 64-MB, 66 MHz, SDRAM 313918-001 

* Memory board (SODIMM), 128-MB, 66 MHz, SDRAM 310345-001 

2 LED status board, 12.1-inch CSTN display 401098-001 

* LED status board, 12.1-inch CTFT display  401103-001 

3 I/O connector 254956-001 

4 DC-DC converter  401106-001 

5 Audio board 401096-001 

6 System board, 266-MHz CPU with 128K cache 401104-001 

* System board, 300-MHz CPU with 128K cache 401100-001 

7 56K modem 401105-001 

*  Not illustrated 
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3.5  Options 

 

 
Figure 3-5. Options  
 

 

Table 3-5 
Options 

Item Description Spares Part Number 

1 External AC adapter with DC power cord 
(US/Canada) 

401095-001 

2 Automobile/Aircraft adapter 313919-001 

3 Lithium Ion battery pack 254960-001 

4 External battery charger 254970-001 

*  Not illustrated 
 



 

3-8    Illustrated Parts Catalog 

 

3.6  Miscellaneous Parts 

 

 

Figure 3-6. Miscellaneous Parts 

 

Table 3-6 
Miscellaneous Parts 

Item Description Spares Part Number 

 
1 

Plastics kit includes:  
Left clutch cover 

254981-001 

2 Microphone/Display cable cover   
3 Right clutch cover   
4 RTC battery cover   
5 CD-ROM/DVD-ROM access door  
6 Modem access door  
* Rubber feet for base enclosure assembly  

7 Fan 108857-001 

* Logo kit 401099-001 

* Miscellaneous parts kit (includes 
microphone)  

254981-001 

* Screw kit  254980-001 

* Return Kit 254972-001 

*  Not illustrated 
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3.8  Documentation 

 

Table 3-7 
Documentation 

Item Description Spares Part Number 

* Armada 1500c Series Illustrated Parts Map (10 ea) 104694-001 
* Armada 1500c Series Maintenance and Service Guide 104695-001 
* Armada 1500c Series Reference Guide 104726-001 

* Country kit 103591-001 
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chapter
 4

REMOVAL AND REPLACEMENT
PRELIMINARIES

This chapter provides general service information for the Armada 1500c Series.
Adherence to the procedures and precautions described in this chapter is essential for
proper service.

4.1  Electrostatic Discharge
A sudden discharge of static electricity from a finger or other conductor can destroy
static-sensitive devices or microcircuitry. Often the spark is neither felt or heard, but
damage occurs. An electronic device exposed to electrostatic discharge (ESD) may not
be affected at all and will work perfectly throughout a normal cycle. Or it may function
normally for a while, then degrade in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many
cases, the discharge contains enough power to alter device parameters or melt silicon
junctions.
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Generating Static
Table 4-1 shows how different activities generate static electricity and at different
electrostatic voltage levels.

Table 4-1
Typical Electrostatic Voltages

Relative Humidity

Event 10% 40% 55%
Walking across carpet 35,000 V 15,000 V 7,500 V
Walking across vinyl floor 12,000 V 5,000 V 3,000 V
Motions of bench worker 6,000 V 800 V 400 V
Removing DIPS from plastic tubes 2,000 V 700 V 400 V
Removing DIPS from vinyl trays 11,500 V 4,000 V 2,000 V
Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V
Removing bubble pack from PCBs 26,000 V 20,000 V 7,000 V
Packing PCBs in foam-lined box 21,000 V  11,000 V 5,000 V

NOTE:  700 volts can degrade a product.

Preventing Electrostatic Damage to Equipment
Many electronic components are sensitive to ESD. Circuitry design and structure
determine the degree of sensitivity. The following proper packaging and grounding
precautions are necessary to prevent damage:

■ Protect all electrostatic parts and assemblies with conductive or approved
containers or packaging.

■ Keep electrostatic-sensitive parts in their containers until they arrive at
static-free stations.

■ Place items on a grounded surface before removing them from their
container.

■ Always be properly grounded when touching a sensitive component or
assembly.

■ Place reusable electrostatic-sensitive parts from assemblies in protective
packaging or conductive foam.

Use transporters and conveyors made of antistatic belts and metal roller bushings.
Mechanized equipment used for moving materials must be wired to ground and proper
materials selected to avoid static charging. When grounding is not possible, use an
ionizer to dissipate electric charges.

Removing Batteries
Compaq recommends that you remove all batteries from the computer before
beginning the disassembly procedures. Failure to do so could cause damage to
computer components.



Removal and Replacement Preliminaries    4-3

Preventing Damage to Drives
To prevent static damage to hard drives:

■ Handle drives gently, using static-guarding techniques.
■ Store drives in the original shipping containers.
■ Avoid dropping drives from any height onto any surface.
■ Handle drives on surfaces that have at least one inch of shockproof foam.
■ Always place drives with the PCB assembly-side down on the foam.

Grounding Methods
The method for grounding must include a wrist strap or a foot strap at
a grounded workstation. When seated, wear a wrist strap connected to a grounded
system. When standing, use footstraps and a grounded floor mat.  Table 4-2 shows the
protection levels for each grounding method.

Table 4-2
Static-Shielding Protection Levels

Method Voltages

Antistatic plastic   1,500
Carbon-loaded plastic   7,500
Metallized laminate 15,000

Grounding Workstations
To prevent static damage at the workstation:

■ Cover the workstation with approved static-dissipative material. Provide a
wrist strap connected to the work surface and properly grounded tools and
equipment.

■ Use static-dissipative mats, heel straps, or air ionizers to give added protection.
■ Handle electrostatic sensitive components, parts, and assemblies by the case or PCB

laminate. Handle them only at static-free workstations.
■ Avoid contact with pins, leads, or circuitry.
■ Turn off power and input signals before inserting and removing connectors or test

equipment.
■ Use fixtures made of static-safe materials when fixtures must directly contact

dissipative surfaces.
■ Keep work area free of non-conductive materials such as ordinary plastic assembly

aids and Styrofoam.
■ Use field service tools, such as cutters, screwdrivers, and vacuums that are

conductive.
■ Use a portable field service kit with a static dissipative vinyl pouch that folds out of

a work mat. Also use a wrist strap and a ground cord for the work surface. Ground
the cord to the chassis of the equipment undergoing test or repair.
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Grounding Equipment
Use the following equipment to prevent static electricity damage to the equipment:

Wrist Straps are flexible straps with a minimum of 1 megohm +/- 10% resistance to
the ground cords. To provide proper ground, a strap must be worn snug against the
skin. On grounded mats without banana-plug connectors, connect a wrist strap with
alligator clips.

Heel straps/Toe straps/Bootstraps can be used at standing workstations and are
compatible with most types of boots and shoes. On conductive floors or dissipative
floor mats, use straps on both feet with a minimum of 1 megohm resistance between
operator and ground. To be effective, the conductive strips must be worn in contact
with the skin.

Recommended Materials and Equipment
Other materials and equipment that are recommended for use in preventing static
electricity include:

■ Anti-static tape
■ Anti-static smocks, aprons, and sleeve protectors
■ Conductive bins and other assembly or soldering aids
■ Conductive foam
■ Conductive table-top workstations with ground cord of 1 megohm

of resistance
■ Static dissipative table and floor mats with hard tie to ground
■ Field service kits
■ Static awareness labels
■ Wrist straps and footwear straps providing 1 megohm +/- 10% resistance
■ Material handling packages
■ Conductive plastic bags
■ Conductive plastic tubes
■ Conductive tote boxes
■ Metal tote boxes
■ Opaque shielding bags
■ Transparent metallized shielding bags
■ Transparent shielding tubes
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4.2  Service Considerations
Following are some considerations to keep in mind during the disassembly and
assembly of the computer.

Tool Requirements
■ Magnetic Torx T-8 screwdriver
■ Flat-bladed screwdriver (optional)
■ 7-mm socket wrench
■ 5-mm socket wrench/screw driver
■ Preloaded application diskettes

IMPORTANT:  To reassemble the computer, set the Torx T-8 screwdriver to
3-inch lbs.

Cables and Connectors
Apply only the tension required to seat or unseat the cables during insertion or removal
from connectors. Handle cables by the connector or pull tabs whenever possible. In all
cases, avoid bending, twisting, or tearing the cables, and ensure that cables are placed
in such a way that they cannot be caught or snagged by parts being removed or
replaced.

CAUTION:  Improper cable placement can cause severe damage to the unit. Ensure
that cables are placed in their proper location during the reassembly process when
servicing these computers.

4.3  Serial Number
The computer serial numbers should be provided to Compaq whenever requesting
information or ordering spare parts. The serial number is located on the rear of the
computer.
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chapter
 5

COMPUTER REMOVAL AND
REPLACEMENT PROCEDURES

This chapter provides the removal and replacement procedures for the computer.

5.1  Serial Number
The computer serial number should be provided to Compaq support when requesting
information or ordering spare parts. The serial number is displayed on the rear of the
CPU (Figure 5-1).

Figure 5-1. Serial Number

NOTE:  This model does not have an AC connector port.  It has a recessed, sealed
opening to allow docking with a convenience base.
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5.2  Disassembly Sequence Chart
This chart shows the order in which disassembly procedures are performed:

5.3  Preparing the Computer for Disassembly
5.3.1  Disconnecting the AC Power
5.3.2  Undocking the Computer
5.3.3  Battery Pack
5.3.4  DualBay Devices
5.3.5  PCMCIA

5.4  Modem
5.5  CD-ROM or DVD-ROM Drive
5.6  Keyboard
5.7  Memory Expansion Board
5.8  Hard Drive
5.9  Lithium Real-Time Clock Battery
5.10  Microphone/Display Cable Cover and Microphone
5.11  Clutch Covers/Display Assembly

5.11.1  Clutch Covers
5.11.2  Display Assembly

5.12  Top Cover Assembly
5.13  LED Status Panel
5.14  Audio Board and Audio Cable
5.15  DC-DC Converter
5.16  Fan
5.17  I/O Fixture Connector
5.18  System Board
5.19  External Computer Components

5.19.1  Computer Logo
5.19.2  Computer Feet

5.3  Preparing the Computer for Disassembly
Before beginning the removal and replacement procedures:

1. Disconnect the AC power and any external devices (Section 5.3.1).
2. Remove the battery pack (Section 5.3.3).
3. Remove the DualBay device (Section 5.3.4).
4. Remove any PCMCIA cards (Section 5.3.5).
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5.3.1  Disconnecting the AC Power
The first procedure that should be performed on the computer is to disconnect the
power supply and any external devices.

1. Close all applications and turn off the computer.
2. Turn off and disconnect any external devices.
3. Disconnect the AC power cord from the power source.
4. Disconnect the external power supply from the computer.

If the computer is docked in the convenience base, see Section 5.3.2 for undocking
instructions.

5.3.2  Undocking the Computer
If the computer is docked in the convenience base, it must be undocked before
performing additional work. Complete the following steps to undock the computer. If
the computer is not docked in the convenience base, proceed to Section 5.3.3.

1. Disconnect the AC power and any external cables (Section 5.3.1).
2. Close the computer.
3. Pull the docking lever forward to undock the computer.
4. Lift the computer from the convenience base.
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5.3.3  Battery Pack
The battery pack should be removed before performing any internal maintenance on the
computer.

! WARNING:  Metal objects can damage the battery pack as well as the battery
contacts in the battery compartment. To prevent damage, do not allow metal
objects to touch the battery contacts. Place only the battery pack for the
Armada 1500c Series Personal Computer into the battery compartment. Do not
force the battery pack into the handle if insertion does not occur easily.

! WARNING:  Do not crush, puncture, or incinerate the battery pack. Do not
dispose of in water. Do not expose to temperatures higher than 60°C. Do not
open a battery pack, because this damages the pack, makes it unserviceable,
and exposes potentially harmful battery components. There are no field-
serviceable parts located inside the battery pack.

To remove the battery pack from the computer:

1. Turn the computer bottom side up.
2. Slide the battery release latch 1.
3. Remove the battery pack 2.

Figure 5-2. Removing the Battery Pack
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To install the battery pack:

1. Insert the battery into the battery compartment.
2. Push firmly until the battery pack is seated into place 1.

Figure 5-3. Inserting the Battery Pack

CAUTION:  Installing the battery pack upside down can cause the contacts to
break.
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5.3.4  DualBay Devices

CAUTION:   The device in the DualBay must be removed prior to performing
maintenance on the computer.

! WARNING:  Metal objects can damage the battery pack as well as the battery contacts
in the battery compartment. To prevent damage, do not allow metal objects to touch the
battery contacts. Place only the battery pack for the Armada 1500c Series into the
battery compartment. Do not force the battery pack if insertion does not occur easily.

! WARNING:  Do not crush, puncture, or incinerate the battery pack. Do not dispose of in
water. Do not expose to temperatures higher than 60°C. Do not open a battery pack,
because this damages the pack, makes it unserviceable, and exposes potentially
harmful battery components. There are no field-serviceable parts located inside the
battery pack.

NOTE:  If a battery pack is used in the DualBay, use the battery release latch to release
the battery.

Either a diskette drive or a modular battery pack may be installed into the DualBay.
The device in the DualBay must be removed prior to performing maintenance on the
computer. For convenience, a diskette drive is depicted in this sequence. To remove the
DualBay device:

1. Turn the computer bottom side up.
2. Pull the diskette drive release latch 1 toward the front of the computer.
3. Remove the diskette drive 2.

Figure 5-4.  Removing the DualBay Device
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To install the DualBay device:

1. Insert the diskette drive into the DualBay compartment
2. Push firmly until the diskette drive is seated into place.

Figure 5-5.  Installing the DualBay Device
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5.3.5  PCMCIA
Remove any installed PC (PCMCIA) cards before performing any service on the
computer. To remove a PC Card:

1. Rotate the PC card eject lever to the forward position 1.
2. Press the PC card eject button 2.
3. Pull the PC card out of the PC Card slot 3.

Figure 5-6. Removing the PC Card

To install a PC card, insert the card into the slot and press firmly until it is seated.

NOTE:  Before replacing the system board, the PC card eject levers must be in the
forward position. See Section 5.18 on removing the system board.
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5.4  Modem
The modem is an upgrade for the Armada 1500c Series. If the model is not equipped
with a modem, the modem compartment is sealed off by a protective plate.

For models equipped with a modem, complete the following steps for removal.

1. Turn the computer bottom side up.
2. Remove two screws from the base enclosure and remove the modem access door 1.
3. Carefully pull the modem board release tab 2.

Figure 5-7. Removing the Modem Access Door
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4. Carefully lift the modem board and remove.

Figure 5-8. Removing the Modem

To replace or install the modem, reverse the procedure.
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5.5  CD-ROM or DVD-ROM Drive
Either a CD-ROM drive or a DVD-ROM drive may be installed in the unit. For
convenience, a CD-ROM drive is depicted in this sequence. To remove the CD-ROM
or DVD-ROM drive and access door:

1. Turn the computer bottom side up.
2. Remove two screws from the CD-ROM  access door.

Figure 5-9. Removing the CD-ROM or DVD-ROM Drive Access Door
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3. Remove the CD-ROM .

Figure 5-10. Removing the CD-ROM or DVD-ROM Drive

To install the CD-ROM drive, reverse the procedure.
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5.6  Keyboard
To remove the keyboard:

1. Disconnect the AC power and any external devices (Section 5.3.1).
2. Remove the battery pack (Section 5.3.3).
3. Remove the DualBay device (Section 5.3.4).
4. Remove any PCMCIA cards (Section 5.3.5).
5. Turn the computer bottom side up.
6. Remove the screws near the rear of the computer from the battery and DualBay

compartments and from the bottom of the base 1. These screws remove the
keyboard.

NOTE:  It is not necessary to remove the screws 2 unless you are going to remove the
top cover assembly.

7. Remove the upper screws 2 from the battery and DualBay compartments. These are
the remaining base enclosure screws.

Figure 5-11. Removing the Keyboard Screws
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8. Turn the computer top side up.
9. Lift the keyboard and rest it on the keyboard slots on the top cover.

NOTE:  It is not necessary to disconnect the keyboard cable to remove the memory
expansion board, hard drive, or RTC battery.

10. Slide back the ZIF connector to release the keyboard cable.

Figure 5-12. Lifting the Keyboard
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11. Slide the keyboard cable strain relief tab toward you, then pull the tab up to remove it from the slot.

12. Carefully lift the keyboard up and away.

.

Figure 5-13. Removing the Keyboard

To replace the keyboard, reverse the steps.
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5.7  Memory Expansion Board
If a memory expansion board option has been previously installed in the computer, it
must be removed before another is installed. To remove the memory expansion board:

1. Disconnect the AC power and any external devices (Section 5.3.1).
2. Remove the battery pack (Section 5.3.3).
3. Remove the DualBay device (Section 5.3.4).
4. Remove any PCMCIA cards (Section 5.3.5).
5. Raise the keyboard (Section 5.6).

CAUTION:   Release the locking tabs that secure the memory expansion board in
the slot.  Failure to release the locking tabs can break the connectors and damage
the system board.

6. Release the right 1 and left 2 locking tab at each end of the memory expansion
board. This releases the memory expansion board and allows it to rotate upward to
ease removal.

Figure 5-14. Releasing the Memory Expansion Board
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7. Lift 1 the free edge of the memory expansion board slightly and pull 2 it straight
out of the slot.

Figure 5-15. Removing the Memory Expansion Board
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To install the memory expansion board:

1. Insert the memory expansion board into the memory slot 1.
2. Pivot the memory expansion board so that it lays flat in the memory compartment 2.
3. Push the memory expansion board firmly into place to seat the connections and to

engage the locking tabs.

Figure 5-16. Installing the Memory Expansion Board
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5.8  Hard Drive
To remove the hard drive and retaining clip:

1. Disconnect the AC power and any external devices (Section 5.3.1).
2. Remove the battery pack (Section 5.3.3).
3. Remove the DualBay device (Section 5.3.4).
4. Remove any PCMCIA cards (Section 5.3.5).
5. Raise the keyboard (Section 5.6).
6. Remove hard drive retaining clip by squeezing both ends of the retaining clip 1

together, then lifting up 2.

Figure 5-17. Removing the Hard Drive Retaining Clip
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7. Slide the hard drive to the right.
8. Lift the hard drive from the hard drive compartment.

Figure 5-18. Removing the Hard Drive

Reverse the above procedure to install the hard drive.
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5.9  Lithium Real-Time Clock Battery

! WARNING:  Incorrect replacement or improper handling of the battery increases
the risk of explosion and injury. Do not attempt to recharge, disassemble, immerse
in water, or dispose of it in fire. Replacement should be done using the Compaq
spare part for this computer.
CAUTION:  Rock the RTC battery cable connector from side to side to disconnect it.
Failure to do so can damage the RTC battery cable.

To remove the Lithium real-time clock (RTC) battery:

1. Disconnect the AC power and any external devices (Section 5.3.1).
2. Remove the battery pack (Section 5.3.3).
3. Remove the DualBay device (Section 5.3.4).
4. Remove any PCMCIA cards (Section 5.3.5).
5. Raise the keyboard (Section 5.6).
6. Remove the Lithium real-time clock (RTC) battery cover.

Figure 5-19. Removing the RTC Battery Cover
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7. Disconnect the RTC battery connector from the system board 1.
8. Remove the RTC battery 2.

Figure 5-20. Removing the RTC Battery

Reverse the procedure to install a replacement RTC battery.
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5.10  Microphone/Display Cable Cover and Microphone
To remove the microphone and microphone/display cable cover:

1. Disconnect the AC power and any external devices (Section 5.3.1).
2. From the rear of the computer, remove two screws securing the microphone/display

cable cover from the base enclosure.

Figure 5-21. Removing the Microphone/Display Cable Cover Screws
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3. Remove the microphone/display cable cover by rotating the cover 1 and lifting it
from the rear of the computer 2.

Figure 5-22. Removing the Microphone/Display Cable Cover

4. Disconnect the microphone from the audio cable.
5. Remove the microphone.

Figure 5-23. Removing the Microphone
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5.11  Clutch Covers/Display Assembly

5.11.1  Clutch Covers
To remove the left and right clutch covers, lift them from the ends of the computer.

Figure 5-24. Removing the Clutch Covers

Reverse the procedure to install the clutch covers.
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5.11.2  Display Assembly
To remove the display assembly:

1. Disconnect the AC power and any external devices (Section 5.3.1).
2. Remove the battery pack (Section 5.3.3).
3. Remove the DualBay device (Section 5.3.4).
4. Remove any PCMCIA cards (Section 5.3.5).
5. Remove the microphone/display cable cover (Section 5.10).
6. Remove the clutch covers (Section 5.11.1).
7. Remove two screws from each clutch and the clutch tension plate that secure the

display to the base enclosure 1.
8. Disconnect the display cables from the base enclosure 2.
9. Lift the display assembly from the base enclosure.

Figure 5-25. Removing the Display Assembly

Reverse the procedure to replace the display assembly.

CAUTION:  Attach the ground cable before attaching the display cables when
replacing the display assembly to avoid damaging the display and ground cables.
CAUTION:   Use the new screws from the screw kit when replacing the display
assembly.  Using the old screws can damage the display assembly and ground
cables.



Computer Removal and Replacement Procedures    5-27

5.12  Top Cover Assembly
To remove the top cover assembly:

1. Disconnect the AC power and any external devices (Section 5.3.1).
2. Remove the battery pack (Section 5.3.3).
3. Remove the DualBay device (Section 5.3.4).
4. Remove any PCMCIA cards (Section 5.3.5).
5. Remove the keyboard (Section 5.6).
6. Remove the microphone/display cable cover (Section 5.10).
7. Disconnect speaker connectors 1 and touchpad cable 2 and RTC battery connector
3 from the system board.

Figure 5-26. Disconnecting the Speaker Connectors, Touchpad Connector, and RTC
Battery Connector From the System Board
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8. From the rear of the computer, remove four screws securing the top cover assembly
to the base enclosure.

Figure 5-27.  Removing Top Cover Assembly Screws
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9. Carefully remove the top cover assembly from the base enclosure.

Figure 5-28. Removing the Top Cover Assembly

To replace the top cover assembly, reverse the steps.
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5.13  LED Status Panel
To remove the LED status panel board:

1. Disconnect the AC power and any external devices (Section 5.3.1).
2. Remove the battery pack (Section 5.3.3).
3. Remove the DualBay device (Section 5.3.4).
4. Remove any PCMCIA cards (Section 5.3.5).
5. Remove the keyboard (Section 5.6).
6. Remove the microphone/display cable cover and microphone (Section 5.10).
7. Remove the clutch covers/display assembly (Section 5.11.1).
8. Remove the top cover assembly (Section 5.12).
9. Remove the 2 screws 1 securing the status panel board.

10. Disconnect the LED status panel board 2 from the system board.

Figure 5-29. Removing the LED Status Panel Board

To replace the LED status panel, reverse the steps.
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5.14  Audio Board and Audio Cable
1. To remove the audio board and audio cable:
2. Disconnect the AC power and any external devices (Section 5.3.1).
3. Remove the battery pack (Section 5.3.3).
4. Remove the DualBay device (Section 5.3.4).
5. Remove any PCMCIA cards (Section 5.3.5).
6. Remove the keyboard (Section 5.6).
7. Remove the microphone/display cable cover and microphone (Section 5.10).
8. Remove the clutch covers/display assembly (Section 5.11.1).
9. Remove the screw 1 from the audio board.

10. Disconnect the audio cable 2.

11. Slide the audio board 3 from the connector on the system board and remove the audio board.

Figure 5-30. Removing the Audio Board

CAUTION:   Do not use the long T-8 screw to secure the Audio board. Use of the
long screw can damage the system board.

To replace the audio cable or audio board, reverse the steps.
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5.15  DC-DC Converter
To remove the DC-DC converter:

1. Disconnect the AC power and any external devices (Section 5.3.1).
2. Remove the battery pack (Section 5.3.3).
3. Remove the DualBay device (Section 5.3.4).
4. Remove any PCMCIA cards (Section 5.3.5).
5. Remove the keyboard (Section 5.6).
6. Remove the microphone/display cable cover and microphone (Section 5.10).
7. Remove the clutch covers/display assembly (Section 5.11.1).
8. Remove the top cover assembly (Section 5.12).
9. Remove the screw that secures the DC-DC converter to the base enclosure.

Figure 5-31. Removing the DC-DC Converter Screw
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10. Disconnect the DC-DC converter from the system board.

11. Pull the DC-DC converter away from the plastic tab separating the DC-DC converter from the I/O
fixture connector 1.

12. Remove the DC-DC converter 2.

Figure 5-32. Disconnecting and Removing the DC-DC Converter

To replace the DC-DC converter, reverse the steps.

CAUTION:  The DC-DC converter board is secured by a short T-8 screw. Do not use
the long T-8 screw to secure the DC-DC converter board. Use of the long screw can
damage the system board.
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5.16  Fan
To remove the fan:

1. Disconnect the AC power and any external devices (Section 5.3.1).
2. Remove the battery pack (Section 5.3.3).
3. Remove the DualBay device (Section 5.3.4).
4. Remove any PCMCIA cards (Section 5.3.5).
5. Remove the keyboard (Section 5.6).
6. Remove the microphone/display cable cover and microphone (Section 5.10).
7. Remove the clutch covers/display assembly (Section 5.11.1).
8. Remove the top cover assembly (Section 5.12).
9. Disconnect the fan from the system board.

10. Remove the fan from the base enclosure.

Figure 5-33. Removing the Fan

Reverse the procedure to install the fan.

IMPORTANT:  When installing the fan, orient the fan so that the label and airflow
direction arrow point to the rear of the computer.
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5.17  I/O Fixture Connector
To remove the I/O fixture connector:

1. Disconnect the AC power and any external devices (Section 5.3.1).
2. Remove the battery pack (Section 5.3.3).
3. Remove the DualBay device (Section 5.3.4).
4. Remove any PCMCIA cards (Section 5.3.5).
5. Remove the keyboard (Section 5.6).
6. Remove the microphone/display cable cover (Section 5.10).
7. Remove the clutch covers/display assembly (Section 5.11.1).
8. Remove the top cover assembly (Section 5.12).
9. Remove the LED status panel board (Section 5.13).

10. Remove three screws securing the I/O fixture to the rear of the computer.

Figure 5-34. Removing the Screws from the I/O Fixture Connector
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11. Remove the I/O fixture connector.

Figure 5-35. Removing the I/O Fixture Connector

To replace the I/O fixture connector, reverse the steps.
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5.18  System Board
To remove the system board:

1. Disconnect the AC power and any external devices (Section 5.3.1).
2. Remove the battery pack (Section 5.3.3).
3. Remove the DualBay device (Section 5.3.4).
4. Remove any PCMCIA cards (Section 5.3.5).
5. Remove the top cover assembly (Section 5.12).
6. Remove the I/O fixture connector (Section 5.17).
7. Remove the screws 1 securing the system board to base enclosure.
8. Disconnect the CD-ROM/DVD-ROM cable 2.
9. Remove the two screws 3 from the rear of the computer that secure the expansion

connector to the base enclosure.

Figure 5-36. Disconnecting the System Board
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10. Tilt up the system board 1.

11. Lift the system board away from the base enclosure 2.

Figure 5-37. Removing the System Board

To replace the system board, reverse the steps.

NOTE:  Before replacing the system board, the PC card eject levers must be in the
forward position. See Section 5.3.5 for proper positioning of the PC card eject levers.
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5.19  External Computer Components
This section describes the removal and replacement procedures that do not require
access to the internal components of the computer. This includes:

n Computer logo
n Computer feet

5.19.1  Computer Logo
The computer logo is on the outside of the display assembly and can be replaced if
damaged. To replace the logo:

1. Use a small, sharp, flat-bladed screwdriver to pry up the existing logo.
2. Clean the area with a clean dry cloth.
3. Apply the new logo.

5.19.2  Computer Feet
There are four locations where the computer feet can be applied. To replace the
computer feet:

1. Peel the old foot from the computer. Use a razor blade if needed to lift a corner of
the foot free from the base cover.

2. Clean the area where the new foot is to be applied with a clean dry cloth.
3. Install the new foot, pressing it firmly into place.
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chapter
 6

SPECIFICATIONS

This chapter provides physical and performance specifications for the following:

■ Computer

■ Displays

■ Hard drive

■ Diskette drive

■ CD-ROM drive

■ DVD-ROM drive

■ Battery packs

■ External power supplies

The chapter also includes:

■ System interrupts

■ System DMA

■ System I/O addresses

■ System memory map
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6.1  Computer

Table 6-1
Computer Specifications

U.S. Metric

Dimensions
  Height
  Depth
  Width

2.09 in.
9.65 in.

12.24 in.

 53.01 mm
245.11 mm
310.90 mm

Weight
  With NiMH battery, 12.1 CTFT display, modem, floppy
diskette drive, CD-ROM, and AC adapter

7.7 lb 3.49 kg

Standalone (Battery) Power Requirements
  Nominal operating voltage (Li-Ion) 14.4 VDC
  Nominal operating voltage (NiMH) 9.6 VDC
  Maximum operating power 39.0 W
External AC Adapter Requirements
  Operating voltage 90 to 264 VAC RMS
  Operating current 1.10 A RMS
  Operating frequency range 47 to 63 Hz AC
  Maximum transient 4/50 kV
  Maximum input power < 75W
Automobile/Aircraft Adapter DC Input Requirements
  Operating voltage 11 to 16 VDC
  Operating power 85.0 W
Temperature
  Operating 50 to  95°F   10 to 35°C
  Non-operating -22 to 140°F -30 to 60°C
Relative Humidity (noncondensing)
  Operating 10 to 90%
  Non-operating  (tw = 38.7°C max)   5 to 90%
Altitude
  Operating 0 to 10,000 ft 0 to 3,480 m
  Non-operating 0 to 30,000 ft 0 to 9,144 m
Shock
  Operating   10 G, 11 ms, half sine
  Non operating   240 G, 2 ms, half sine
Vibration
  Operating 0.5 G, 10 to 500 Hz, 0.25 Oct/Min sweep rate
  Non-operating 1.5 G, 10 to 500 Hz, 0.5 Oct/Min sweep rate

NOTE:  Applicable product safety standards specify thermal limits for plastic surfaces.
The Compaq Armada 1500c Series operates well within this range of temperatures.
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6.2  Displays

Table 6-2
12.1-Inch DSTN, SVGA Display

U.S. Metric

Dimensions (maximum)
  Height
  Width

7.97 in.
10.80 in.

202.5 mm
275.0 mm

Number of Colors 262 K
Contrast Ratio 40:1 typical
Pixel Resolution
  Pitch
  Format
  Configuration

0.29 × 0.29 mm
800 × 600
RGB Stripe

Brightness
 Minimum (No flickering)

100cd/m² (nits) typical
90cd/m² (nits) minimum

Backlight Edge Lit
Character Display 80 × 25

Table 6-3
12.1-Inch CTFT, SVGA Display

U.S. Metric

Dimensions (maximum)
  Height   7.67 in. 195.0 mm
  Width   10.80 in. 275.0 mm
Number of Colors 262 K
Contrast Ratio 100:1 minimum
Pixel Resolution
  Pitch
  Format
  Configuration

.03075 x 0.3075 mm
800 x 600
RGB Stripe

Brightness 130 cd/m² (nits) typical
120 cd/m² (nits) minimum

Backlight Edge Lit
Character Display 80 × 25
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6.3  Hard Drive
Table 6-4

Hard Drive Specifications
4.0-GB

Logical Capacity per Drive (MB) 4,099,866,624
Drive Type   65
Drive Height
  With drive frame 2.5 in./12.7mm
Drive Size
  Inches 2.5 x 0.5
  Millimeters 102.0 x 75
Transfer Rate
  Media (Mb/s) 51.4-83.4 MB/s
  Interface (Mb/s) 16.6 MB/sec
Sector Interleave     1:1
Typical Seek Time (Including setting)
  Single Track (ms) 4 ms
  Average (ms) 13 ms (read)
  Full Stroke (ms) 32 ms (read)
Disk Rotational Speed (RPM) 4009
Physical Configuration
  Cylinders 6975
  Data Heads 6
  Sectors/Track 144 to 240
  Bytes/Sector 512
Logical Configuration
  Cylinders 7944
  Heads 16
  Sectors per Track 63
  Bytes per Sector 512
Buffer Size 512 KB
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6.4  Diskette Drive

Table 6-5
Diskette Drive Specifications

Diskette size 3.5-inch (88.9 mm)
  High density 1.44 MB/1.2 MB
  Low density 720 KB
Light None
Height 0.43 in. (11 mm)
Bytes per sector 512
Sectors per Track
  High density 18 (1.44 MB)/15 (1.2 MB)
  Low density   9
Tracks per Side
  High density 80 (1.44 MB)/80 (1.2 MB)
  Low density 80
Read/Write heads   2
Average Seek Times
  Track-to-Track (high/low)     3 ms/6 ms
  Average (high/low)   94 ms/174 ms
  Settling Time   15 ms
  Latency Average 100 ms
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6.5  CD-ROM Drive

Table 6-6
CD-ROM Drive Specifications

Applicable Disc CD-ROM mode 1, mode 2
CD-Digital Audio
CD-XA mode 2 (Form 1, Form 2)
CD-I mode 2 (Form1, Form 2)
CD-I Ready
CD-Bridge
CD-R
CD-WO (fixed/variable packets)
Photo CD (single/multisession)

Center Hole Diameter 15 mm
Disc Diameter 12 cm, 8 cm
Disc Thickness 1.2 mm
Track Pitch 1.6  µm
Laser
  Beam divergence 53.5 ± 1.5 degrees
  Output power 0.24 ± 0.1 mw
  Type Semiconductor Laser GaA1As
  Wave length 780 nm ± 25 nm
Access time
  Random <350 ms
  Full stroke <750 ms
Audio output level
  Line out 0.7 Vrms
  Headphone None
Cache Buffer 128 KB
Data transfer rate
  Sustained, 24x 3.6 MB/s
  Sustained, single 150 KB/sec
  Burst 8.3 MB/sec
  Startup time <8 seconds typical
Capacity
Mode 1, 12 cm 550 MB
Mode 2, 12 cm 640 MB
8 cm 180 MB
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6.6  DVD-ROM Drive

Table 6-7
DVD-ROM Drive Specifications

Disc Formats Supported DVD-5, DVD-9, DVD-10, DVD-18
CD-ROM mode 1, mode 2
CD-Digital Audio
CD-XA mode 2 (Form 1, Form 2)
CD-I mode 2 (Form1, Form 2)
CD-I Ready
CD-Bridge
CD-R
Photo CD (single/multisession)
Video CD

Center Hole Diameter 15 mm
Disc Diameter 12 cm, 8 cm
Disc Thickness 1.2 mm
Track Pitch 1.6  µm
Capacity 4.7-GB - DVD-5

8.5-GB - DVD-9
9.4-GB - DVD-10
550-Mbytes (Mode 1, 12)
640 Mbytes (Mode 2, 12 cm)
180 Mbytes (8 cm)

  17.1 - DVD -18
Laser
  Output power 5mw
  Type Semiconductor laser GaA1As
  Wave length 650 nm ± 25 nm (DVD Mode)

795 nm ± 25 nm (CD-ROM mode)
Access time
  Random <200 ms
  Full stroke <250 ms
Audio output level
  Line out 0.7 Vrms
  Headphone None
Cache Buffer 128 KB
Data Transfer Rate
  Sustained, 1x (CD-ROM mode) 150 KB/sec
  Sustained, 20x CD-ROM CAV mode 1200-3000 KB/sec
  Sustained, DVD mode 2760 Kbytes/s sustained, DVD mode
  Burst 16.6 MB/sec
  Startup time <15 seconds typical
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6.7  Battery Packs

Table 6-8
Nickel Metal Hydride Battery Pack

U.S. Metric

Dimensions
  Height 0.82 in.   20.8 mm
  Length  5.8 in.   147.32 mm
  Width  3.2in.   81.3 mm
Electrical
  Voltage  9.6 V
  Watt-hour capacity  36 Wh
Battery Life > 2 hours
Environmental Requirements
  Operating temperatures 50°F to 95°F  10°C to 35°C
  Non-operating temperatures -22°F to 140°F -30°C to 60°C

Table 6-9
Lithium-Ion Battery Pack

U.S. Metric

Dimensions
  Height 0.82 in.   20.8 mm
  Length  5.8 in.   147.32 mm
  Width  3.2 in.   81.3 mm
Electrical
  Voltage 14.4 VDC
  Watt-hour capacity  39 Wh
Battery Life up to 2.5 hours
Environmental Requirements
  Operating temperatures 50°F to 95°F  10°C to 35°C
  Non-operating temperatures -22°F to 140°F -30°C to 60°C
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6.8 External Power Supplies
The automobile adapter allows the computer to be used in an automobile without
causing a drain on the computer’s batteries.

Table 6-10
Automobile/Aircraft Adapter

U.S. Metric

Dimensions
  Height  1.42 in. 36 mm
  Width  2.83 in. 72 mm
  Length  4.84 in. 123 mm
Weight 0.88 lb 400 gm
Input Cord Length 3.281 ft. 1.0 m
Power Supply (Input)
  Nominal voltage 13.8 VDC
  Operating voltage 10.5 - 14.8 VDC
  Maximum voltage 16.0 VDC
  Input fuse protection 8.0 A
Temperature
  Operating 32 to 104°F     0 to 40°C
  Non-operating  -4 to 140°F  -20 to 60°C

Relative Humidity
  Operating 10 to 90%
  Non-operating   5 to 95%
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The external AC adapter provides power for the system unit.

Table 6-11
External AC Adapter

U.S. Metric

Power Supply (Input)
  Nominal voltage 90 to 264 VAC
  Line frequency 47 to   63 Hz
Power Supply (Output)
  Nominal voltage +18 ± 0.5 VDC
  Power 45 W
Temperature
  Operating 50º to 95ºF 10º to 35ºC
  Non-operating -22º to 140ºF -30º to 60ºC

Relative Humidity
  Operating 10% to 90%
  Non-operating 10% to 95%

Table 6-12
External Battery Charger
U.S. Metric

Dimensions
  Height 1.57 in 40 mm
  Width 5.25 in 133 mm
  Length 9.4 in 239 mm
Weight 1.1 lb 4.95 gm
Power Supply (Input)
  Nominal voltage +18.5 +/- 0.25 VDC
  Current 40 to 42 W
Power Supply (Output)
  Nominal voltage +18.5 +/- 0.25 VDC
  Current 40 to 42 W
Temperature
  Operating 41 to 104°F 5 to 40°C
  Non-operating -4 to 185°F -20 to +85°C

Relative Humidity
  Operating 10 to 95%
  Non-operating 10 to 95%
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6.9  System Interrupts

Table 6-13
System Interrupts

Hardware IRQ System Function

IRQ0 Timer interrupt
IRQ1 Keyboard
IRQ2 Interrupt controller cascade
IRQ3 COM 2 - used by MSIO or PCMCIA controller
IRQ4 COM 1 - used by MSIO or PCMCIA controller
IRQ5 Used by either audio or PCMCIA controller
IRQ6 Diskette drive controller
IRQ7 Used by either EPP parallel or audio
IRQ8 Real-time clock (MSIO)
IRQ9 Used by either audio or PCMCIA controller
IRQ10 Used by either audio or PCMCIA controller
IRQ11 Used by PCMCIA
IRQ12 Mouse
IRQ13 Floating point error input
IRQ14 Hard drive
IRQ15 Convenience base NIC interrupt

6.10  System DMA

Table 6-14
System DMA

Hardware DMA System Function

DMA 0 Not assigned
DMA 1 Audio controller
DMA 2 Diskette drive controller
DMA 3 EPP Parallel port
DMA 4 Not assigned
DMA 5 Audio controller
DMA 6 Not assigned
DMA 7 Not assigned



6-12    Specifications

6.11  System I/O Addresses

Table 6-15
System I/O Addresses

I/O Address (Hex) System Function (Shipping Configuration)
000 - 00F Master DMA controller # 1
010 - 011 Force software SMI
012 - 01F Unused
020 - 021 Peripheral interrupt controller # 1
022 - 024 Opti chipset configuration registers
025 - 03F Unused
040 - 043 Counter/timer registers
044 - 05F Unused
060 Keyboard data
061 Port B
062 - 063 Unused
064 Keyboard command/status
065 - 06F Unused
070 CMOS index address
071 CMOS data
072 - 073 Unused
074 Reserved
075 Unused
076 Reserved
077 - 077F Unused
080 - 08F DMA page registers
084 - 085 POST code output port
090 - 091 Unused
092 Fast reset register
093 - 09F Unused
0A0 - 0A1 Interrupt controller # 2
0A2 - 0BF Unused
0C0 - 0DF DMA controller # 2
0E0 - 0E1 ESS audio configuration
0E2 - 0E5 Configuration registers
0E6 - 0EF Unused
0F0 - 0F1 NCP numerics register
0F9 ESS configuration lock
0FA Unused
0FB ESS configuration unlock
0FC - 0FF Unused
100 - 101 Unused
103 - 16F Unused

Continued
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Table 6-15 System I/O Addresses Continued
I/O Address (Hex) System Function (Shipping Configuration)
170 - 177 Hard drive secondary registers
178 - 1EF Unused
1F0 - 1F7 Hard drive primary  registers
1F8 - 1FF Unused
200 - 21F Unused
220 - 22F ESS audio registers (1st possible) (default)
230 - 23F ESS audio registers (2nd possible)
240 - 24F ESS audio registers (3rd possible)
250 - 25F ESS audio registers (4th possible)
260 - 277 Unused
278 - 27A LPT2  and high speed parallel port  registers
27B - 27F LPT2 high speed printer port registers
280 - 2F7 Unused
2F8 - 2FF Serial control register COM2
300 - 36F Unused
370 - 371 Reserved
372 Diskette digital output register
373 Unused
374 Reserved
375 Diskette main status/data registers
376 Reserved
377 Diskette input/control registers
378 - 37A LPT1 and high speed parallel port registers
37B - 37F Unused
380 - 387 Unused
388 - 38B ESS FM synthesizer
38C - 3AF Unused
3B0 - 3BB Cirrus logic video controller
3BC - 3BE LPT3 and high speed parallel port  registers
3BF LPT1 high speed parallel port registers
3C0 - 3CD Cirrus logic video controller
3D0 - 3DF Cirrus logic video controller
3F0 - 3F7 Diskette drive controller primary registers
3F8 - 3FF COM1 serial controller registers
400 - 4CF Unused
480 - 48F Extended DMS registers
4D0 - CF6 Unused
CF7 Configuration/NVM data register
CF8 - CFB PCI configuration index register
CFC - CFF PCI configuration index register
D00 - FFF Unused
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6.12  System Memory Map

Table 6-16
System Memory Map

Size Memory Address System Function

640 K 00000000 - 0009FFFF Base memory
128 K 000A0000 - 000BFFFF Video memory
  48 K 000C0000 - 000CBFFF Video BIOS
160 K 000C8000 - 000E7FFF Unused
  64 K 000E8000 - 000FFFFF System BIOS
 15 M 00100000 - 00FFFFFF Extended memory
 58 M 01000000 - 047FFFFF Super extended memory
 58 M 04800000 - 07FFFFFF Unused
   2 M 08000000 - 080FFFFF Video memory (direct access)
   4 G 08200000 - FFFEFFFF Unused
 64 K FFFF0000  - FFFFFFFF System BIOS ("SHADOW")
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CONNECTOR PIN ASSIGNMENTS

This appendix contains the pin assignments for all external connectors.

Table A-1
External Keyboard

Connector Pin Signal

1
2
3
4
5
6

Data
Unused
Ground
+5 VDC
Clock
Unused

Table A-2
PS/2-Compatible Mouse

Connector Pin Signal

1
2
3
4
5
6

Data
Unused
Ground
+5 VDC
Clock
Unused

Table A-3
MIDI/Game

Pin Signal Pin Signal

1 +5 V   9 +5 V
2 Joystick Button 10 Joystick Button
3 Joystick Direction 11 Joystick Direction
4 Ground 12 MIDI Out
5 Ground 13 Joystick Direction
6 Joystick Direction 14 Joystick Button
7 Joystick Button 15 MIDI In
8 +5 V
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Table A-4
Ethernet RJ-45

Connector Pin Signal

1
2
3
4
5
6
7
8

(+) Transmit Data
(-) Transmit Data
(+) Receive Data
Unused
Unused
(-) Receive Data
Unused
Unused

Table A-5
External Monitor

1

6

11

5

10

15

Pin Signal Pin Signal

1 Red Analog   9 Blank
2 Green Analog 10 Ground
3 Blue Analog 11 Blank
4 Blank 12 Monitor ID (DD)
5 Ground 13 Horizontal Sync
6 Ground 14 Vertical Sync
7 Ground 15 Monitor ID (CC)
8 Ground
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Table A-6
Parallel

Pin Signal Pin Signal

1 Strobe 14 Auto Linefeed
2 Data Bit 0 15 Error
3 Data Bit 1 16 Initialize Printer
4 Data Bit 2 17 Select In
5 Data Bit 3 18 Ground
6 Data Bit 4 19 Ground
7 Data Bit 5 20 Ground
8 Data Bit 6 21 External Diskette Positive Drive Detect
9 Data Bit 7 22 External Diskette Negative Drive Detect
10 Acknowledge 23 Ground
11 Busy 24 Ground
12 Paper End 25 External Diskette Drive Switched to +5 V
13 Select

Table A-7
Serial Port

1

6 9

5

Pin Signal Pin Signal

1 Carrier Detect 6 Data Set Ready
2 Receive Data 7 Ready to Send
3 Transmit Data 8 Clear to Send
4 Data Terminal Ready 9 Ring Indicator
5 Ground

Table A-8
AC Power Connector

Pin Signal Pin Signal

1 Neutral (right) 3 Live (left)
2 Ground (center)
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Table A-9
Expansion Connector

Pin Signal Pin Signal

1 GND 31 GREEN
2 GND 32 CRTVSYNC
3 NC 33 RED
4 GND 34 DDCCLK
5 GND 35 PWRLED
6 NC 36 DDCDATA
7 GND 37 DOCK_PWR_EN
8 GND 38 GND
9 AD[31] 39 SPKL
10 DEVSEL 40 LINE_L
11 IRDY 41 SPK_R
12 STOP 42 LINE_R
13 TRDY 43 GND
14 GND 44 DOCK_LG
15 GND 45 GND
16 AD[12] 46 GND
17 AD[13] 47 REQ1
18 GND 48 REQ0
19 GND 49 GNTO
20 CLK1 50 RST
21 AD[0] 51 GND
22 GND 52 AD[23]
23 DOCK_S 53 AD[22]
24 CLK0 54 C/BE2
25 ACVCC 55 AD[20]
26 ACVCC 56 NC
27 ACVCC 57 AD[19]
28 ACVCC 58 FRAME
29 ACVCC 59 AD[17]
30 CRTHSYNC 60 GND

Continued
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Table A-9  Expansion Connector  Continued

Pin Signal Pin Signal

61 GND 96 GND
62 AD[14] 97 CBE3
63 AD[15] 98 AD[21]
64 AD[1] 99 NC
65 AD[3] 100 NC
66 AD[2] 101 AD[18]
67 GND 102 C/BE1
68 MDATA 103 PAR
69 KBDATA 104 GND
70 MCLK 105 AD[16]
71 KBCLK 106 AD[6]
72 ACVCC 107 C/BE0
73 PMVCC5 108 AD[5]
74 PMVCC5 109 AD[7]
75 NC 110 AD[4]
76 BLUE 111 BATTLED
77 NC 112 SWC
78 PBUSY 113 TA
79 PDATA7 114 SWB
80 PBDATA3 115 SWD
81 PSLIN 116 SWA
82 GND 117 PMVCC5
83 GND 118 PMVCC5
84 SPK_IN 119 PMVCC5
85 +5v 120 PMVCC5
86 NC 121 PSELECT
87 ERDY 122 PDADA6
88 SYSVCC5A 123 PACK
89 STANDBy_SW 124 PDATA2
90 NC 125 PDATA0
91 NC 126 PFAULT
92 NC 127 GND
93 NC 128 GND
94 GNT1 129 DSRA
95 GND 130 DCDA

Continued
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Table A-9  Expansion Connector  Continued

Pin Signal Pin Signal

131 RTSA 154 AD[8]
132 RIA 155 PORT_REP
133 POWER_SW 156 MSI
134 INTB 157 MSO
135 NC 158 TC
136 INTA 159 TD
137 NC 160 TB
138 GND 161 PMVCC5
139 NC 162 PMVCC5
140 AD[27] 163 PPE
141 AD[30] 164 PMVCC5
142 AD[26] 165 PDATA4
143 AD[29] 166 PDATA5
144 AD[25] 167 PDATA1
145 AD[28] 168 PINIT
146 AD[24] 169 PSTB
147 BLOCK 170 PAFD
148 GND 171 GND
149 PERR 172 GND
150 SERR 173 CTSA
151 AD[11] 174 SINA
152 AD[9] 175 DTRA
153 AD[10] 176 SOUTA

Table A-10
Speaker Connector

Pin Signal

1 Left channel
2 Right channel
3 Common
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POWER CORD SET REQUIREMENTS

3-Conductor Power Cord Set

The wide range input feature of your computer permits it to operate from any line
voltage from 100 to 240 volts AC.

The power cord set received with the computer meets the requirements for use in the
country where you purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country
where you use the computer.

General Requirements

The requirements listed below are applicable to all countries:

1. The length of the power cord set must be at least 5.00 feet (1.5 m) and a maximum
of 6.56 feet (2.0 m).

2. All power cord sets must be approved by an acceptable accredited agency
responsible for evaluation in the country where the power cord set will be used.

3. The power cord set must have a minimum current capacity of 10A and a nominal
voltage rating of 125 or 250 volts AC, as required by each country’s power system.

4. The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC
320 Standard Sheet C5 connector, for mating with appliance inlet on the product.
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Country-Specific Requirements

Table B-1
3-Conductor Power Cord Set Requirements — By Country

Country Accredited Agency Applicable Note Numbers

Australia EANSW 1
Austria OVE 1
Belgium CEBC 1
Canada CSA 2
Denmark DEMKO 1
Finland FIMKO 1
France UTE 1
Germany VDE 1
Italy IMQ 1
Japan JIS 3
Norway NEMKO 1
Sweden SEMKO 1
Switzerland SEV 1
United Kingdom BSI 1
United States UL 2

Notes:
1. The flexible cord must be <HAR> Type HO3VV-F, 3-conductor,  0.75 mm2

conductor size. Power cord set fittings (appliance coupler and wall plug) must bear
the certification mark of the agency responsible for evaluation in the country where
it will be used.

2. The flexible cord must be Type SPT-2 or equivalent, No. 18 AWG, 3-conductor.
The wall plug must be a two-pole grounding type with a NEMA 5-15P (15A,
125V) or NEMA 6-15P (15A 250V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a "T" mark and
registration number in accordance with the Japanese Dentori Law. The flexible
cord must be Type VCT or VCTF, 3-conductor, 0.75mm2 conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303
(15A, 125V) configuration.
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CONVENIENCE BASE II

C.1  Models

The convenience bases provide a permanent desktop solution for the computer by
eliminating the need to disconnect external devices such as a printer, keyboard, or
monitor when you undock the computer. All necessary connections and disconnections
are made automatically when the computer is docked and undocked. The following
convenience models are available:

Table C-1
Models

Model Serial Configuration

Convenience Base Pass through model BNH3

Convenience Base with Ethernet BNH1
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Figure C-1. Convenience Base
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C.2  Features

The Convenience Base II pass through model and the convenience base with Ethernet
model include the following features:

Convenience Base
pass through

Convenience Base
with Ethernet

Connections
Speaker/headphone ■ ■

Audio Line-In ■ ■

Serial ■ ■

Parallel ■ ■

USB ■ ■

External Monitor ■ ■

Keyboard ■ ■

Pointing Device ■ ■

MIDI/Joystick ■ ■

Other Features
Monitor Stand ■ ■

Cable lock provision ■ ■

Pass through AC Power ■ ■

RJ-45 connector ■

10/100 MB/s Ethernet autoswitching ■

Options
Localized Power Cords ■ ■

Cable lock ■ ■
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C.3  Convenience Base II Specifications

Table 3-2
Convenience Base II Specifications

U.S. Metric

Dimensions
  Height   4.9 in. 12.460 cm
  Height w/monitor stand   5.2 in. 13.208 cm
  Length  14.7 in. 37.340 cm
  Width  14.2 in. 36.070 cm
Weight
  Expansion base 4.25 lb 1.93 kg
  Expansion base w/monitor stand 5.80 lb 2.63 kg
Power Supply (Input)
  Operating voltage 100 to 240 VAC
  Operating current 1.10 Amp Maximum
  Rated voltage 100 to 240 VAC
  Rated current 1.0 Amp Maximum
  Line frequency 47 to 63 Hz
Temperature
  Operating 50 to 95°F 10 to 35°C
   Storage -4 to 140°F 20 to 60°C
Relative Humidity
  Operating 10 to 90%
  Storage   5 to 95%
Altitude
  Operating 10,000 ft   3.15 km
  Non-operating 30,000 ft 10.14 km
Shock
  Operating 10 G, 11 ms, half sine
  Non-operating 140 G, 2 ms, half sine
Vibration
  Operating 0.25 G, 5 to 500 Hz, 0.5 octave/min sweep rate
  Non-operating 1.0 G, 5 to 500 Hz, 0.5 octave/min sweep rate
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C.4  Components

The convenience base components are illustrated and described in this section.

C.4.1  Front and Right Side Components

The front and right side convenience base components are shown and identified in this
section.

1 Docking latches

2 Docking alignment pins

3 Docking connector

4 Power switch

5 Security cable lock

6 Docking lever

7 Pass-through AC power outlet

8 Battery charge light

9 Suspend button

: Power/suspend light

; Retaining latches

Figure C-2. Convenience Base Front and Right Side Components
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C.4.2  Rear Components

The rear components are shown in the following figure and identified in this section:

1 RJ-45 jack (Ethernet model only)

2 Serial connector

3 Parallel connector

4 External monitor connector

5 MIDI/Joystick connector

6 Pointing device connector

7 Keyboard connector

8 Speaker/headphone jack

9 Audio Line-in jack

- USB connector

; AC power connector

w Fan

Figure C-3. Convenience Base Rear Components
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C.5  Spare Parts

This section provides spare part references for the Convenience Base II models.

Table C-3
Convenience Base II Models

Item Description Spares Part Number

* Convenience Base II (Pass through model) 316291-001
* Convenience Base II (Ethernet model) 316312-001
* Monitor Stand 254990-001

 * Not illustrated
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